Running a Workshop  17

Day 1: Introduction to Digital Storytelling
a. Objectives/Outcomes of the Day
b. Schedule Day 1
c. PowerPoint presentation: Introduction to DST
d. Tool: Sample DST videos
e. Homework assignment: Draft script

Day 2: The Art of Storytelling
a. Objectives/Outcomes of the Day
b. Schedule Day 2
c. PowerPoint presentation: Elements of Digital Storytelling
d. PowerPoint presentation: The Art of Storytelling
e. Tools: Production schedule, Storyboard Template, Share Plan
f. Supplemental form: Consent Form
g. Homework assignment: Refine script, rehearse voice-over; storyboard

Day 3: Creating Sound
a. Objectives/Outcomes of the Day
b. Schedule Day 3
c. PowerPoint presentation: The Role of Sound
d. PowerPoint presentation: Sound Editing
e. Tool: File organisation
f. Homework assignment: Finalise audio track

Day 4: Visuals
a. Objectives/Outcomes of the Day
b. Schedule Day 4
c. PowerPoint presentation: Images & Photo Editing
d. Homework assignment: Finalise image selection, creation and edit

Day 5: Movie Making
a. Objectives/Outcomes of the Day
b. Schedule Day 5
c. PowerPoint presentation: Making a Movie
d. Tips for reflections and wrap-up
e. Supplemental form: Workshop Evaluation

Hosting a DST Film Screening

DST Workshop Follow-up
About
Women
Win
Women Win is an internationally recognised centre of excellence on gender and sport. We are a thought leader and global convener, strategically positioned at the intersection of women’s rights, development and sport.

Women Win uses sport as a strategy to advance girls’ rights with a focus on three areas:

- Addressing gender-based violence
- Accessing sexual and reproductive health and rights
- Gaining economic empowerment

Since our 2007 inception, we have become most effective as a cross-pollinator of impactful strategies, resources and innovative tools that address gender inequity while empowering adolescent girls and young women.

Our Work

Women Win’s strategy to achieve our mission is based on a constant interplay between our three organisational pillars: Strengthen, Learn and Impact.

STRENGTHEN:
Through grants and capacity building we invest in organisations to deliver sport and empowerment programmes for girls. We partner with both ‘flagships,’ well-established global leaders, as well as smaller, grassroots groups that are employing fresh and innovative approaches.

LEARN:
We collect promising practices and learn from the field with the aim of being a centre of excellence in identifying innovation, building tools and catalysing dialogue that advances organisations’ ability to address girls’ rights through sport.

IMPACT:
We deliver a world-class, evidence-based monitoring and evaluation system, drive an innovative research agenda that bolsters qualified research and substantiated proof, and report with consistency, accuracy and efficiency.

Our Mission:
To equip adolescent girls to exercise their rights through sport

Our Vision:
One Win Leads to Another: By 2016, 1 M adolescent girls realise their leadership potential through sport

Our Values:
Girls are our purpose
Sport is our power
Innovation is our edge
Collaboration is our strength
Change is our promise
What is Digital Storytelling?

A. Definition
Digital Storytelling (DST) is a workshop-based methodology that focuses on the everyday person’s ability to share aspects of their life story. It is grounded in the storytellers’ control over the medium — words, images and audio — so that the process of learning and production is as powerful for the storyteller as the end product is for the audience.

A final digital story is a short video (2–4 minutes) of images, voice, text and music stitched together using low-tech, affordable and accessible technology. Participants narrate first-person scripts that they write and then match with personal photographs, drawings, music and sound effects to tell their story. Once completed, DST stories are easily published online and can be made available to an international audience, depending on the topic and purpose of the project.

The power of DST is in the process, not the product. It’s an opportunity to build young women’s communications and leadership skills, and amplify their voices.

B. History and Framework
The Center for Digital Storytelling, based in California, emerged from the artistic ferment in the United States during the 1970s and 1980s. Practitioners and educators challenged the notion that art should be reserved for the gifted or educated. As they worked to increase access to artistic expression, the wave of technologies in the 1990s offered new tools for expression and fertile ground for experimentation. In 1994, the Digital Media Center was founded, which laid the foundation for the 1998 launch of the Center for Digital Storytelling. The basis of their work is the “...power of personal voice in creating change.”

Many organizations, including development and women’s rights organizations, have adopted participatory media methodologies, including Digital Storytelling. A tool of activism, healing, conflict resolution and empowerment, DST has been adopted to address gender-based violence, land rights, women living in situations of armed conflict, sexual minorities and sex workers.

In 2007, Women'sNet of the Association for Progressive Communications, based in South Africa, took up this methodology in working with women living in situations of domestic violence as well as young black lesbians facing sexual violence due to their sexual orientation. They used the methodology to encourage women’s rights activists to expand their ICTs skills to tell the stories that had the power to influence policy change. Women Win partnered with experts from APC to develop a DST framework that could emphasize girls’ leadership and sport experience.
C. What Makes DST Unique

The most important characteristic of a digital story is that it no longer conforms to the traditional conventions of media, reporting and storytelling. The expressive capabilities and accessibility of technology offers a broad base from which ordinary people have the ability to craft and share their own story.

Narrative Control: The DST methodology differs from all other media (documentaries, film, radio) in that the storyteller is in complete power of the process - the participant chooses exactly what to say and how to say it. As a process, the act of telling one’s story can have a profoundly empowering impact on the storyteller. Participants actively construct and reconstruct themselves and their stories through the process of narration.

ICT Skill Building: Through the process of participating in a DST workshop and producing a story, young women are equipped with computer and Internet skills. Beyond the personal empowerment of the experience, the intention of this training is that young leaders will share these skills with others and integrate digital storytelling into their activist work.

Enabling Access: Compared to traditional media, the digital medium is a relatively affordable and approachable form of technology for non-experts. No previous technical experience is necessary to participate in a workshop and create a digital story. Non-professional equipment and free software applications are used to craft and edit stories.

Alternative Research Tool: Digital stories are rich, layered accounts of human experiences. Unlike traditional research methods such as surveys, they can capture the complexity of growth, challenge, tradition, etc. – which can be linked to the impact pathway and M&E framework.

Feminist Methodology: The goal of empowerment is to enable women to participate in society, influence their own situations and have equal chances as men have. All the unique qualities of DST described above allow for DST to become a very powerful tool for women’s empowerment. The Association of Progressive Communication’s Chat Garcia Ramilo describes the digital storytelling itself as a feminist method, as women get the chance to speak their minds. The separation between a female private sphere and a male public sphere can be destabilized as marginalized women become visible through their digital stories. Through this visibility and increase in women’s stories’ media coverage more female role models emerge, who, in their turn, will inspire more women on a community, national or even global level. What is also important is that, through DST, women and girls not only become more visible, but also have the power to determine the way they are represented, having complete control of both the process and the product of DST.

In addition, the process of DST disrupts traditional hierarchies in multiple ways. By putting story telling power in the hands of women and girls, DST helps them realize that they have stories that deserve to be told and shared. Telling your own story in your own way is an empowering act in itself, but the content of the stories more often than not also challenges traditional gender roles and expectations. In addition, in order to create their own digital stories, women develop new skills related not only to storytelling but also digital technology. With technology being a male-dominated sector, the fact that women develop this new knowledge and use technology to tell their own stories breaks the gender barrier and challenges once again stereotypes about what women can or cannot do.

Finally, the process of digital storytelling is essentially feminist in the way that it becomes collective. Individual women bring their stories to the workshop, and during the sharing process in the story circle they both receive and give input on the stories of the other girls present, thus making the creation of these stories a collaborative process, where girls are supporting each other to refine their stories in the digital storytelling process.
The 7 Elements to Digital Storytelling

The Center for Digital Storytelling (CDS) is known for developing and disseminating the Seven Elements of Digital Storytelling which are often cited as a useful starting point as you begin working with digital stories.

1. Point of View
What is the main point of the story and what is the perspective of the author?

2. A Dramatic Question
A key question that keeps the viewer’s attention and will be answered by the end of the story.

3. Emotional Content
Serious issues that come alive in a personal and powerful way and connects the audience to the story.

4. The Gift of Your Voice
A way to personalize the story to help the audience understand the context.

5. The Power of the Soundtrack
Music or other sounds that support and embellish the story.

6. Economy
Using just enough content to tell the story without overloading the viewer.

7. Pacing
The rhythm of the story and how slowly or quickly it progresses.

the intention of this training is that young leaders will share these skills with others

1 Adapted from http://storycenter.org/
Building Young Women’s Leadership Through Sport

Alongside our mission to equip girls and young women to exercise their rights through sport, Women Win believes sport serves as an effective platform to discover and develop individual leadership.

Sport cultivates the leadership skills inherent in girls, creates an enabling environment in which girls practise leadership skills and allows them to actively use their knowledge and skills to drive change in their own lives and their communities.

Defining Leadership

Over time, Women Win has developed a framework for leadership, which serves as a foundation for all our programmes and activities. Our definition is based on research, theory and experiences around leadership, sports and the skills and development of adolescent girls and young women. The basic premise of our definition of leadership is that leadership is a set of skills, behaviours and attitudes that can be learned, practiced, and refined through experience, mentorship and education. Women Win defines leadership as follows:

*Leadership is the ability of a girl or young woman to effectively utilize available resources, exercise her rights, and ultimately drive change.*

Building Leadership: A Theory of Change:1

Given our definition of leadership, this section is meant to articulate how to go about it. It lays out a specific theory of change to leadership, and identifies possible pathways. Women Win has identified three stages of leadership development in adolescent girls and young women: Prepare, Practice, and Play. They are sequential but fluid. Girls may move from one stage to the next, only to return to a previous stage when they encounter a new situation.

**PREPARE**

A girl discovers and develops her skills and talents, and becomes aware of her leadership potential. She accumulates knowledge and information. She finds the confidence to set challenging goals for herself and strives to live by her values. This includes being proud of where she came from as well as where she’s going.

**PRACTICE**

A girl connects and interacts with others and learns how to team up. Through communication and interaction she learns how to negotiate and exercise her rights and solve conflicts. It’s in this stage that her leadership potential and abilities expand and strengthen.

**PLAY**

A girl exercises her leadership skills. She influences and motivates others, drives change and becomes an agent of change over her own life as well as the lives of people around her.

---

1 Adapted from Linden and Fertman (1998) and Girls Scouts leadership documents.
Identifying Leadership Competencies

Leadership manifests itself in a variety of ways and is driven and supported by many competencies. Women Win has defined four core competencies of leadership as a way of making the concept of improvement more tangible. By categorizing skills and competencies, girls are able to recognize, celebrate, enhance and encourage their leadership development.

In each leadership development stage and throughout all Women Win activities, girls acquire leadership skills, attitudes and knowledge, and develop an array of competencies. Women Win is convinced that its culturally relevant sport programmes, as well as the mentorship programme, digital story telling and community engagement can meet the simultaneous needs of offering girls new venues in which to learn leadership skills, and begin breaking down restrictive gender norms within their families and society at large (“Multiplier effect”).

---

I AM SELF-CONFIDENT
- Identify strengths and celebrate successes
- Take risks and step up to challenges
- Fail forward
- Accept and value diversity

I HAVE VISION
- See a better future
- Set and adapt goals
- Inspire and influence others

I USE VOICE
- Communicate effectively
- Be assertive
- Be critical and self aware

I TAKE ACTION
- Make decisions and solve problems in a critical, empathetic and collaborative way
- Cope with emotions and stress
- Seek creative and innovative approaches

---

OUTCOMES
1. Young leader fellows gain personal leadership skills and feel better and inspired to act as leaders
2. Young leader fellows have increased leadership in their organisations
3. Young leader fellows have increased knowledge of opportunities within their fields

---

Adapted from Care Leadership Document

Connecting Digital Storytelling and Leadership Through Sport

Women Win believes that Digital Storytelling has a unique ability to cultivate leadership potential. During the process, young women are encouraged to strengthen muscles in all six competencies of leadership. Through an intense 5-day DST workshop, Women Win equips girls and young women with technical skills, knowledge and opportunities to share their personal stories of transformation through sport. These may include the challenges they faced, how they overcame them, and the impact sport has had in their lives.

The DST methodology is grounded in the first-person perspective: “I” and “me.” It is this location of the “I” that forms the foundation of the methodology - locating the self in meaningful work to advance social change. In telling/sharing their stories, participants create a sense of ownership for their experiences, discover how much experience and learning they have in common with others, advance solidarity and understanding, and ultimately become visible change-agents in their communities.

By telling her story, a girl puts herself in a position of leadership. This leadership can occur at different levels -- in her own life, giving back to the community or in making an international impact for other girls. When a girl tells her story, she convinces parents and teachers to allow girls to play sport; she convinces leaders of the critical impact her organisation creates in the community; and she supports the global case for the power of sport to build leadership and ultimately transform lives.

Once a young woman learns the skills needed to share her story through DST, it becomes her task and responsibility to share those skills with members of her organisation, capturing more stories and multiplying the effect of the tool. Born from this approach, our ultimate goal with DST is to strengthen our partners’ capacities to communicate the impact of their work they do using sport as an effective strategy for equipping young women with the ability to exercise their rights.

The Digital Storytelling workshop and methodology is part of a larger “Building Leadership Through Sport” suite of tools that Women Win has developed. It is an independent training that is annually coupled with Women Win’s Mentorship program, which aims to accelerate girls’ leadership through connecting them with influential international female leaders.

It becomes her task and responsibility to share those skills with members of her organisation.
How We Work

Partnerships and strategic alliances are a core element to achieving the Women Win mission. The complexity and scale of gender inequality means that no one can effectively tackle it alone. Our collaborations (formal and informal) allow us to increase impact and efficiency and, at their best, are rooted in the virtuous circle of exchange. In all partnerships, we put an uncompromising emphasis on three principles:
• Equity
• Transparency
• Mutual Benefit

One key element to our partnerships is our dedication to identifying and developing innovative tools that serve on-the-ground practitioners. The knowledge used to build these tools comes from constant connection and conversation with Women Win partners around the world. The subject matter is based on needs and trends, and answers questions ranging from mainstream challenges, such as how to address common barriers to girls’ sport participation, to more specific queries, such as effective tools that engage communities in conversations about gender-based violence.

For Digital Storytelling, we have developed 3 levels of engagement:

**Level One: Storytelling Skill Building**
The first level of engagement focuses on experiential learning. The primary objective is for young women to attend as participants and create their own DST videos. Participants are introduced to the digital storytelling methodology and experience the process from start to end. In the spirit of Women Win’s multiplier effect, participants are selected based upon their leadership capacities at their home organisations.

**Level Two: Facilitation and Technical Skill Mastery**
After participants have attended a first DST workshop, some are invited to deepen their training. Here the primary objective is building facilitation skills, in addition to honing technical skills. Participants who come for a Level Two training are given the opportunity to not only produce a second story, but share in the delivery of the workshop and serve as a peer support for Level 1 participants.

**Level Three: Local Facilitation**
The third level of DST is based on hosting a DST training at a partner location. Girls who have been trained by Women Win are encouraged to bring their skills and expertise to their organizations and help others to tell their stories of sport and empowerment through the DST process. This toolkit, in addition to one on one coaching pre and post workshop are options for support as DST trainees lead their own workshops.

---

**Equity**

**Transparency**

**Mutual Benefit**
WW PRINCIPLES OF DIGITAL STORYTELLING

The following principles serve as a set of Women Win’s non-negotiable principles for ethical practice in DST. Our principles grow out of our core value: Girls are our purpose. We strive to ensure the safety and dignity of our digital storytellers worldwide.

Well-Being. Storytellers’ physical, emotional, social, and spiritual wellbeing should be at the centre of all phases of an individual project and workshop. Strategies to ensure the wellbeing of vulnerable participants are particularly important. This is particularly important for facilitators of DST workshops.

Truth. Storytellers must have the space to tell their own stories based upon their personal life experiences. Storytellers are encouraged to experiment with creative approaches; however, the stories with the greatest leverage are those grounded in personal truth.

Informed Choices. Storytellers must have the information and ability to make informed choices about the content, production, use and distribution of their work.

Ownership. Storytellers have the right to freedom of expression in representing themselves in their stories. They should be provided with the space and flexibility to describe what they have experienced, within the parameters of sport, and without being coerced or censored. Storytellers have the right to determine whether or not their names are attached to their stories and whether they use images of themselves/others or if these images are blurred to protect privacy.

Local Context. Workshop facilitators should follow principles of cultural sensitivity and, as appropriate, workshops should be conducted in local languages with co-facilitators who are “cultural insiders.” Methods should be adapted to fit local technological resources and capacities, always emphasising the importance of the first-person voice, group process, and participatory production.

Ethics as Process. Facilitators should view ethics as a process, rather than as a one-off occasion of “gaining consent.” On-going dialogue between storytellers, staff members and coaches, and partner organisations/institutions about how best to design and implement an ethically responsible project is key to ethical practice. Discussion and decision-making about the responsible distribution of stories should be a key aspect of this dialogue.

Adapted from: http://storycenter.org/ethical-practice/
The Impact

As stated, DST is a valuable tool to promote and support development of girls and young women as leaders in their organisations and communities. Knowledge, together with the experiences and skills acquired through participation in the DST workshops and the enabling structures created by sport programmes and organisations themselves, create the following pathway. This pathway of impact is our way of measuring, or proving, the impact of DST at the individual level of the girl, at the organizational level, and at the community level. These levels align with our Prepare - Practice - Play levels of leadership. We understand that, on these three levels, DST can have the following impact:

1. A girl strengthens her leadership skills and builds her self-confidence
   - Girls are challenged to improve their leadership competencies by increasing their story telling skills, such as using hooks, narrative arcs, plot development and storyboarding
   - Girls improve their ICT skills:
     - Overall computer literacy and skill application
     - Narration, audio recording and editing skills
     - Image generation, selection and editing skills
     - Video editing skills, such as compiling audio and image files along a timeline, compression, transitions, and appropriate credits
     - Web publishing and social media skills

2. A girl efficiently uses her voice, negotiates and exercises her rights
   - Girls learn how to facilitate a DST workshop at their own organisation and at partner organisations
   - Girls assume a leadership position within their organization as the representative at the DST workshop
   - Girls practice leadership by sharing and using their stories:
     - Organisations build capacity to advocate and raise awareness about their program and its impacts by sharing the girls’ stories
     - Organisations improve strength in monitoring and evaluation by using stories to document, share and assess the impact of sport on girls’ lives. DST participants build narration, audio recording and editing skills
     - Organisations build community engagement strategies through collecting girls’ stories and using them to engage various stakeholders
     - Organisations build capacity to mobilise resources/fundraise by leveraging digital stories

3. A girl takes action and drives change
   - Girls practice leadership by sharing their stories on a local, regional and global level. In this way they develop a network of young female leaders, as well as role models and mentors
   - Girls practice leadership by taking action to drive change within their organisations and communities by using their digital stories for community events (i.e. DST film screening)
   - DST provides a platform for the girls to advance/influence discourse as the stories become “visual evidence” and thus can provoke debate

3 levels of influence:

Individual
Organisation
Community
Workshop Basics

Each Women Win DST workshop has a tailored agenda that reflects the specific needs of participants. Generally speaking, workshops are oriented towards the impact of sport on individuals, organisations and communities. Five-day workshops are intense, demanding a high-level of focus and commitment. Typically there are no more than 10 participants, in order to maintain a low facilitator to participant ratio (1:5) and an intimate environment. Women Win adapts its methodology to fit with available equipment, language abilities and internet access.

Participants and facilitators are expected to attend the entire workshop. Trust in story sharing is critical to its success and thus requires a full commitment from each person present. Women Win employs a strict code of confidentiality throughout the workshop so participants can express themselves in a safe space, without inhibition.

Women Win DST workshops can and should be adapted to fit the context, equipment available and needs of the participants. For example, if you have trouble meeting the minimal equipment requirements you may want to consider planning and facilitating an Audio Storytelling workshop (AST) instead of a full DST (see Women Win’s AST Toolkit). Also, if you have participants who are hearing or sight impaired, you can adapt the workshop to be purely visual or purely audio, by using some of the DST toolkit, even if not all.
A. Overall DST Objectives
The objectives for DST include:
• Improve girls’ leadership by equipping them with the DST tool and ICT skills to amplify their voices locally, regionally, nationally and internationally
• Empower girls to participate in society, influencing decisions that impact their lives
• Enable girls to advocate for changes that will challenge gender norms and improve the lives of many other girls and women in their communities and nations
• Improve organisations’ capacities to share the impact of their work within their communities and amongst key stakeholders
• Build a global repository of stories that make the case for sport as an effective strategy for developing girls’ leadership

B. Expectations of a DST Workshop
Below is a list of Women Win’s expectations from a DST workshop.
• Create films, share films!
• Develop and execute share plans
• Integrate DST workshops within the ‘movement’ of their work, sharing their skills with other girls
• Engage third-party audiences: the media, community members, etc. to demonstrate the impact of sport and their organisation, as well as advance discourse for change
• Contribute to WW’s online platform with films to help advance the discourse and build the case for sport.

C. Elements of a DST Workshop
There are twelve elements of a Women Win DST workshop.

1. Ice breaker, introductions and energisers: Relaxing the participants and helping them to feel more comfortable with the facilitators and other participants is essential. Given the high-demand for focus and long hours in front of a computer, it is important to infuse the workshop with energisers (see Resources for a list of ideas).

2. Overview: We share the overarching objectives of digital storytelling: what it is and why we do it. We also discuss the elements of digital stories and view examples of digital stories.

3. Share plans: The intention for these films is that they will be shared by individuals and their organisations to advance their work. As such, it’s critical to explore basic communications strategies during the workshop, such as identifying target audiences, developing appropriate messaging, connecting with media outlets, planning screenings, etc. Each participant then develops her own share plan, complete with a timeline, for sharing their story.

4. Script Writing: We teach participants about the art of storytelling, including how elements such as visuals and audio add depth to the story and should be considered alongside the words we write. We also discuss types of stories, the story arc and hook to provide a pedagogical approach to crafting compelling stories.

5. Story circle: Participants read their stories aloud for the first time during the sacred space of a story circle. During this process, participants are encouraged to provide constructive feedback to their peers as a means of supporting the creative process. This element is very important and it is vital to allow enough time so that participants have the liberty and space to engage in the full DST process. It is also important the story circle remain a safe space, without outside spectators.

6. Storyboarding: Once the script is final, participants map out which visuals will be used along a precise story timeline. Storyboards are critical in maintaining an efficient use of time and keeping to the production schedule, as they eventually inform the video compilation process on the final day.
7. **Recording the voiceover**: Participants read and record their own scripts. This is usually done using some type of voice recorder, but can also be a mobile phone or computer microphone.

8. **Visuals**: This aspect of the training focuses on the use of visuals to enhance stories, including personal photographs, illustrations, creative projects and internet-accessed imagery. Using a basic image editing software application, we work with still images to resize, crop, blur and employ other tools for a creative look and feel to the images that will enhance the story; in some instances participants may include video clips. We encourage the use of self-illustrated visuals (drawings, paintings, sketches) in addition to or instead of photographs.

9. **Movie making**: Participants put the audio and visual aspects together to craft the final story. This is most commonly done using Windows MovieMaker or iMovie. Basic film editing skills are taught, including the use of screen transitions, animations, title frames and end credits. The final film is rendered and exported as a movie file that can be uploaded or copied.

10. **Copyright, consent and ownership**: In support of ethical practices, we include discussion related to copyright, the Creative Commons license. We also discuss consent and the ethics of if, who and how the stories can be used as well as the young women’s basic rights as storytellers.

11. **Reflection**: Watching one’s own words and visuals often serves as a mirror into the past. It is important to allow time for discussion and personal reflection related to the DST process after the completion of workshop.

12. **Screening**: Hosting a DST film screening where an audience views the digital stories is an excellent opportunity to celebrate the accomplishment of creating a film. It also enables participants to experience first-hand how it feels to have their stories shared in a public space.

**D. Five-day Overview**

Below is a table to summarise a standard DST workshop programme that spans the recommended 5-day period. It includes the main topic of the day as well as key learning.

<table>
<thead>
<tr>
<th>DAY</th>
<th>MAIN TOPICS</th>
<th>KEY LEARNINGS</th>
</tr>
</thead>
</table>
| 1   | About Digital Storytelling | • Elements of a digital story  
• Art of storytelling  
• Leadership, Sport and DST |
| 2   | Script writing and storyboarding  
Audience  
Ownership and consent | • Creating a compelling story script  
• Audience identification and message development  
• Ownership, copyright, credit and consent |
| 3   | Role of sound | • Uses of sound and silence  
• Recording, importing and editing sound |
| 4   | Role of visuals | • What makes a good visual or image  
• Editing images |
| 5   | Movie making | • Tying it all together to create a film  
• Reflections on DST process |
Running a workshop
Preparation

A. Getting Ready
Hosting a successful DST workshop requires thorough preparation and organisation on the front end. It is important to think through all aspects of the workshop, from the social cohesion of the participants to the daily logistics of food and toilets. By being fully prepared, organisations and facilitators are better poised to adapt to unforeseen situations that arise during the week.

Six Weeks Prior
- Set the date
- Create a participant list with contact information
- Consider how many facilitators are needed based on the target group size; enlist others if need be
- Research venues for the workshop and the final DST screening

Four Weeks Prior
- Create an invitation and send it to the participant list
- Secure workshop venue
- Consider and invite local partners as guest speakers
- Identify technological equipment needs and begin to gather what is needed
- Update all templates, forms, presentation material as needed (i.e. preparation e-mail with current dates)

Three Weeks Prior
- Finalise participants, send Introductory e-mail with attached Preparation Document and Participant Needs Assessment Survey
- Follow up with participants who have not responded
- Confirm details for venue and any equipment reservations
- Make any arrangements for food if providing, to include tea/coffee breaks and lunches
- Test all equipment to ensure each works properly

Two Weeks Prior
- If participants are under age, obtain parental/guardian consent
- Confirm participant transportation details if necessary
- Review Needs Assessment Survey responses, follow-up with participants who have not submitted
- If possible, prepare the venue.
- Test equipment at the venue, including internet access and electrical outlets
- Account for all items on the Workshop Equipment Checklist (pg. x)
- Upload current anti-virus programme and software applications needed on each computer/laptop
- Familiarise yourself with the equipment

One Week Prior
- Confirm any guest speakers or field trips (i.e. to a local radio station)
- Confirm food arrangements
- Familiarise yourself with the venue (lighting, internet password, location of toilets, etc.)
- Address any needs
- Review the workshop’s daily agendas
- Print any documents needed (Consent Forms, DST Certificates, Evaluations),
- Consider which can be saved to a USB
- Double-check Workshop Equipment Checklist (pg. x)
- Troubleshoot as needed
- Write your story!

Day Prior
- Prepare venue, if not yet done
- Test all equipment, secure cables to the floor with tape as needed to avoid tripping
- Ensure sound-proof space for recording
- Shop for any snacks

Day of
- Arrive early in case you encounter any surprises
- Double-check everything is in place and working properly
- Have fun!

TOP TIP
Consider local partners and contacts that might add rich texture to the workshop. For example, radio hosts, filmmakers, journalists, ICT women would be great guest speakers. Other partners might be able to donate equipment, venue space and/or food.
B. Choosing a Venue

Choosing an appropriate venue is critical to the success of the workshop and helps establish security, trust and confidence among the participants. The venue should be safe and comfortable, preferably with natural light and air. It should also be accessible to persons with disabilities. Keep in mind that too much light will interfere with participants’ ability to see the projected screen, which is critical for presentations, tutorials and screenings. Ideally the venue will be open early and available after hours so that participants are not constrained by time.

There should be enough space for each participant to work comfortably and a separate space (it can be small) for audio recording that is relatively soundproof. It should provide the capacity to support the technological needs of the workshop, such as access to a reliable Internet connection and sufficient power outlets.

Additionally, there should be a space at or near the venue where any participant who needs some private time can go and not be disturbed. This can be a separate room.

To maintain an up-beat energy throughout the workshop, it is ideal to have a venue that includes an outdoor space for energisers, play or discussion-related tutorials. As venues are considered, it is good to keep in mind an appropriate location to host a final DST Film Screening. This may be the same venue as the workshop or, depending on the organisation of the event, it may be more appropriate to host the screening in an alternate location or room.

C. Equipment and Supplies

Given the tech-heavy nature of DST, it is important to carefully consider which equipment is both accessible and necessary to host a successful workshop. This may help dictate the number of participants a workshop is capable of hosting. Lack of sufficient equipment could lead to interruptions that cause major delays or, worst case, could stop the workshop altogether.

In addition to the technological equipment required, there is a list of supplies Women Win encourages facilitators to have on-hand to support the creative process. This includes items such as a whiteboard or flipchart, as well as markers, crayons and paper.

Below is a list of considerations for both the venue and equipment. ‘Minimum requirements’ are those that Women Win feel are absolutely necessary to the success of a DST workshop. ‘The Ideal Arrangement’ reflects the perfect situation.

TOP TIP
A car works as a good sound booth if needed. Sit inside, close the doors and windows, and record.
<table>
<thead>
<tr>
<th>TYPE OF EQUIPMENT</th>
<th>MINIMUM REQUIREMENTS</th>
<th>IDEAL ARRANGEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Space</td>
<td>Room with sufficient individual workspace</td>
<td>Table/desk and chair for each participant</td>
</tr>
<tr>
<td></td>
<td>Space to gather as a group (i.e. sit in a circle)</td>
<td>Separate outdoor, group, and work spaces</td>
</tr>
<tr>
<td></td>
<td>Small room or secluded space for recording</td>
<td>Sound-proof recording studio</td>
</tr>
<tr>
<td></td>
<td>Clear wall for DST example screening</td>
<td>Pull-down screen</td>
</tr>
<tr>
<td>Technical Equipment</td>
<td>A couple computers that can be shared; time is booked in increments according to the number of participants and pace of workshop</td>
<td></td>
</tr>
<tr>
<td>Computers/Laptops</td>
<td>• Computers/laptops must have a soundcard, attached mouse, minimum 10GB of space</td>
<td>Individual laptop or computer for each participant</td>
</tr>
<tr>
<td></td>
<td>• Ensure antivirus programme is up-to-date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Laptops should have Audacity and Gimp downloaded</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Windows Moviemaker or iMovie should be installed</td>
<td></td>
</tr>
<tr>
<td>Facilitator laptop</td>
<td>A computer dedicated for facilitator presentations, tutorials and DST viewing (participants can gather around)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A facilitator-only laptop dedicated for presentations, tutorials and DST viewing</td>
<td></td>
</tr>
<tr>
<td>Power sources</td>
<td>Sufficient power sources even if sharing</td>
<td>Plug-in source for each laptop</td>
</tr>
<tr>
<td>Access to Internet</td>
<td>Reliable internet access</td>
<td>USB memory sticks for each participant with anti-virus programme downloaded</td>
</tr>
<tr>
<td>Microphone for audio recording</td>
<td>Computers/laptops should have a built-in microphone for recording</td>
<td>Portable audio recorder/external microphone and accessories, extra batteries</td>
</tr>
<tr>
<td>External speakers</td>
<td>Facilitator laptop with soundcard/built-in speakers</td>
<td>External speakers</td>
</tr>
<tr>
<td></td>
<td>*keep in mind how this may affect the quality of a DST Film Screening</td>
<td></td>
</tr>
<tr>
<td>Projector</td>
<td>LCD Projector and cables or final DST Film Screening</td>
<td>LCD Projector and cables throughout workshop, screening</td>
</tr>
<tr>
<td>Hard drives for saving</td>
<td>One shared external hard-drive to back-up files saved on the computer/laptop (minimum 500GB)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>*In addition to the minimum, USB memory sticks for each participant (can include the antivirus programme)</td>
<td></td>
</tr>
<tr>
<td>Visual creation</td>
<td>Access to images or supplies to create visuals for story</td>
<td>Digital camera with cords and SD card reader</td>
</tr>
<tr>
<td>Audio editing</td>
<td>A couple sets of shared headsets or earphones</td>
<td>Headsets or earphones for each participant</td>
</tr>
<tr>
<td>Supporting Technical Equipment</td>
<td>Access to a printer/scanner to import visuals</td>
<td>Laser printer with white paper</td>
</tr>
<tr>
<td>Supplies</td>
<td>Flip-chart or chalkboard (with chalk and eraser)</td>
<td>Portable scanner to import visuals</td>
</tr>
<tr>
<td></td>
<td>• Markers, crayons, pens and/or pencils</td>
<td>• Markers, crayons, pens, coloured pencils</td>
</tr>
<tr>
<td></td>
<td>• White paper</td>
<td>• Paint and paint brushes</td>
</tr>
<tr>
<td></td>
<td>• Scissors, tape, glue</td>
<td>• Clay or play-doh</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• White and coloured paper</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scissors, tape, glue, blue tak</td>
</tr>
<tr>
<td>Forms</td>
<td>Adequate number of supplemental forms</td>
<td>Adequate number of supplemental forms</td>
</tr>
</tbody>
</table>
D. Facilitator Readiness

A core responsibility of the facilitators is to ensure that the workshop is an engaging, safe and supportive space so participants can create their stories openly and with confidence. There should always be two facilitators, one lead facilitator and the other to support. Below we have highlighted the three necessary sets of skills that facilitators need to run a successful workshop.

In addition to these skills, sensitivity towards differences between participants and trainers/facilitators and creating a space of learning and mutual respect is critical. Facilitators should be aware of these differences, including unspoken dynamics, and turn them into learning opportunities rather than barriers. The differences in experiences, culture, race and age of facilitators and participants should be carefully considered. Facilitating a space where these differences can be up-fronted and discussed is essential to holding the sharing space of the workshop. It is important that facilitators be flexible and capable of tuning into the evolving space of the workshop. This means being able to quickly adapt, adjust and re-route according to the needs of the participants.

OTHER CONSIDERATIONS

Differences and Vulnerability: During a DST workshop participants open up and share very private stories that evoke strong emotions and put people in a vulnerable position. It is important to carefully consider each participant’s level of emotional maturity and resilience in sharing, reacting and responding to the DST process. A facilitator needs to consider that participants might be facing discrimination and/or peer pressure because of their ethnic/tribal/caste background, disabilities or sexual orientation. This means that they could have great difficulty opening up and feeling confident about sharing their stories for fear of receiving negative feedback. When working with young participants, especially under the age of 25, a facilitator needs to keep in mind that vulnerability and peer pressure are even more prominent during that age. Thus, facilitators should be careful to hold the storytelling space with care and awareness of potential non-resilience when dealing with emotionally charged stories that may not have been told before.

External Support: Organizations embarking on DST workshops should be prepared to assist girls during and after the workshop, should issues arise that require professional counsel or outside support. Best practice would be for organizations to establish a protocol of first-response and follow-up prior to a workshop so the facilitator and other involved persons know exactly what to do and who to contact without hesitation should a situation arise. We recommend having a GBV or trauma counsellor who is informed about the workshop and the DST process and who is on call to provide support to any participant who needs it.

Schedule: DST workshop schedule can become quite intense with long hours. Facilitators must be willing to work outside normal hours to support the participants in the DST process as needed.

E. Participant Readiness

Age: Women Win targets young women between the ages of 16- and 30-years-old for the DST workshops we host. In conducting your own workshop, it is critical to gain consent from parents/guardians through a signed consent form for anyone participating who is legally a minor.

Digital Literacy: Digital literacy and comfort levels using technology must be considered. There may be different levels of familiarity (or not) with computers depending on the educational backgrounds of the young women and access at their organisations. Although DST requires no computer experience, these levels will affect the pace of the workshop. A mix of digital literacy levels provides the opportunity for peer-to-peer learning where those with more technical experience confidence are able to help those without.

Language Literacy: Literacy levels (spoken, written and reading) will impact the workshop. It is important to pay attention to the learning paradigms that present during the course of a workshop. For example, a young woman with a minimal literacy level may not be comfortable writing and reading her script and may prefer a process of word lists and memorization. In addition, some participants may be more comfortable working in English and others in their mother tongues. This dynamic should be considered when assessing the group's overall composition.
F. Facilitator's Success Profile

Facilitation of a DST workshop requires skills and competencies in a variety of areas, including basic facilitation, computer and digital technologies and story design and delivery. Below is a checklist of skills that are necessary for successful delivery of a DST workshop and can be used to identify qualified facilitators.

1. Facilitation
   A Digital Storytelling facilitator should:
   - Be well prepared
   - Have adequate and thorough knowledge of what she/he is going to teach
   - Be able to manage time effectively
   - Inspire creativity and participation
   - Be confident
   - Be responsible for her/his actions as well as for the group and the process
   - Demonstrate resiliency, flexibility and adaptability
   - Be respectful and encouraging; give constructive feedback which affirms the wisdom of the group
   - Be attentive and able to understand underlying group dynamics
   - Be objective and able to maintain boundaries and personal integrity
   - Be able to report back on the process and identify successes, challenges and potential ways to improve

2. Computer and Digital Technology
   Having experience using other audio, image and video editing software can be helpful to DST facilitators. However, it is not a sufficient replacement to being able to navigate and teach in the software the participants will be using, in that case GIMP, Audacity and Movie Maker/iMovie.
   - File organisation
   - How to use the internet and download applications
   - How to download sound and images
   - Audio editing skills in Audacity:
     - Highlighting Audio
     - Zoom
     - Effects/Amplify
     - Time Shift Tool
     - Scissors
     - Copy/Paste
     - Panning/Volume
     - Envelope
     - Adding a new layer
     - Add silence
     - Fade effects

EMOTIONAL RESILIENCE OF FACILITATOR

Storytelling can be profoundly personal and bring up emotions that are difficult to deal with, for both the storyteller and the audience. Telling personal stories can sometimes trigger strong emotions, and can be difficult for girls and young women who have experienced trauma or violence.

As a facilitator, you must be prepared to deal with this situation should it arise, not only for the well-being of the participants, but also for your own well-being.

Facilitators should take the time before, during and after the workshop to reflect on their emotional reactions, their capacity to deal with challenging situations and their overall resiliency.

Remember that good facilitation and your ability to facilitate a successful workshop is dependent on your well-being, so take care of yourself and take time for reflection at the end of each day.
3. Story Design and Delivery

a. Writing Experience: Experience in writing and editing your own story is essential for a thorough understanding of the skills necessary to help others in writing their scripts and following the story arc. We recommend that facilitators take some time to research story arc, listen to story samples and review the DST Powerpoint slides on story arcs. The more that facilitators write, edit and tell their own stories, the more they will become experts to help others. Thus, creating your own Digital Story prior to facilitating a workshop is essential. In addition Digital Storytelling facilitators should be familiar and confident with the following aspects of a story:

- Creating scenes
- Designing story arcs
- Developing characters
- Various plot types
- Making transitions
- Identifying and using hooks

b. Story Circle: The story circle is the most important part of the process of creating personal stories. It is important that the facilitator create a safe space for the story circle, in which every participant feels that they are listened to and can contribute. It is also important that any criticism or suggestions made during the story circle are constructive and that they respect the creativity and personal choices made by the story writer.

Tips for Story Circle:
- Make sure that the only people in the room during Story Circle are the participants and facilitators who will share their stories
- Start with a relaxation/trust exercise that will enable participants feel more comfortable sharing the deeply emotional stories that they are about to tell
- Create a circle of chairs, separate from the workspace you are using, where everyone will sit during the story circle
- Give every participant sufficient time to read their entire story, and make sure they are not interrupted by other participants talking, phones ringing, external noise etc.
- Look participants in the eye as you speak to them about their stories
- If there is a heavily emotional story that is told, take a brief break to stretch and make some body movements
- Share your own story, and make sure any other facilitators share, and take comments about your story from the participants
- Encourage peer to peer feedback
Tips for new facilitators

**Tip 1:** Read this toolkit completely through, including a review of PowerPoint presentations and resources.

**Tip 2:** Always explain the schedule for the workshop before you start, and talk about expectations that participants may have. You may even want to start every day of the workshop with giving the schedule for the day. This way you and the participants are all on the same page, and there will be less confusion about what is going to come next.

**Tip 3:** Plan you time. Not only should you practice beforehand so that you know how much time you will need for each part of the workshop, but you should also prepare extra time for questions at the end of every activity. Remember that not everyone learns at the same speed and something that seems easy to you may not be easy for one of your participants. Be patient and leave plenty of time in your schedule to repeat explanations and answer questions if necessary.

**Tip 4:** Speak clearly and slowly. The most important thing is that all your participants can understand you. Be sure to use a loud and clear voice when you speak to the group, and try to speak slowly.

**Tip 5:** Be encouraging and positive towards participants. Avoid telling them they are wrong or getting frustrated if they do not understand something right away. All participation is positive, and you should take comments and questions with a positive attitude, and if they are incorrect, be sure that you give them the correct information in a way that does not make them feel bad.

**Tip 6:** Break up the workshop with little games or physical activities. It is difficult for anyone to sit and listen for hours on end, so it is good to have some little games prepared that you can do with the group when you feel they are getting tired or are losing concentration. This will energise the group and make it easier to continue.

**Tip 7:** Share your own story. Not only is this good practice for you in telling your story, but it will also build trust with your participants and make the workshop a better experience.

**Tip 8:** Ask questions, be curious and interact with participants. Storytelling is not an exact science. There is no right or wrong. The workshop will be a greater success, with more powerful stories and more engaged participants if everyone is encouraged to speak out.

---

**TOP TIP: GROUP DYNAMICS**

Group composition can be important - especially if one of the overarching objectives is to break down social/cultural barriers through the workshop. Consider group dynamics such as: age, race, caste/tribe, religion, levels of education and literacy.
Dear Participant,

Hello to all the digital storytelling workshop participants!

I am planning a training week for people working with 

DST_2  Introduction E-mail 1 - Sample

Please make changes to fit your specific workshop.

To be sent approximately 3–4 weeks prior

Attach docs: Preparation Document and Participant Needs Assessment Survey

DST_3  Introduction E-mail 2

Please make changes to fit your specific workshop.

As follow-up, for missing Participant Needs Assessment Survey, sent 1–2 weeks prior

Attach Participant Needs Assessment Survey

DST_4  Preparation Document (3 x A4)

Please make changes to fit your specific workshop.

DST_5  Participant Needs Assessment Survey

Please make changes to fit your specific workshop.

TOP TIP: SURVEY WITH EASE

You can use free web applications such as Google Forms or SurveyMonkey.com to conduct and track surveys. It’s easy to set-up, and creates a direct link that can be accessed from an e-mail for easy response and easy review.

You can use free web applications such as Google Forms or SurveyMonkey.com to conduct and track surveys. It’s easy to set-up, and creates a direct link that can be accessed from an e-mail for easy response and easy review.
Dear Participants,

Hello and welcome to the Digital Storytelling workshop!
My name is <insert name> and I work with <insert organisation>. I will be facilitating the workshop and am excited to meet you in a couple weeks for some fun with cameras, movies and your stories.

Here are four main things you need to do before you arrive:

• Start thinking about your story! Write your script (250 words), gather photographs (at least 25!) or any other items from home that help tell your story
• Complete the attached survey before <insert date>. You can do this online at: [provide link]
  Or, you can print it, complete it, scan it and e-mail it to me.
• Read through the attached Preparation notes. This includes a list of items to bring with you as well as questions that might help you think about your story.
• Use the camera, take photos, take videos!

The workshop will take place at <insert location address>. It officially begins at <insert time and date>. You will be given additional instruction upon your arrival. Please be on time.

If you have any questions or concerns, please do not hesitate to contact me!

Many thanks and see you soon!

My kindest regards,
<insert facilitator name>
Hello DST Participants,

We are eager to meet you next week at our digital storytelling workshop.

According to my records we still need your responses to our survey regarding technical experience, tools and expectations. Please take the time to do this as soon as possible. It is extremely important to help us ensure we have all the equipment needed for your participation.

You will find the survey, both online and in an attachment, below in the original email. Please contact me if you have any problems or questions. I am happy to help you complete the survey if this is needed.

Thank you for your cooperation on this. And be sure you are practicing with your cameras and thinking about your stories!

See you soon.

Kindly,

<insert facilitator name>
Participant Preparation

Welcome to the Digital Storytelling Workshop! We are eager to meet you and look forward to an incredible learning experience together. It is very important to begin thinking about your story. Please read through the following pages carefully.

The information will help prepare you for the workshop. It covers ideas related to your story: the script, images and photography, music and items to bring with you. If you have any questions or concerns, feel free to contact us. We are here to help! Please also e-mail your draft scripts (read on!) to <insert name>.

Contact:
<insert name and e-mail address>
<insert phone number>

What is Digital Storytelling?
Digital Storytelling (DST) is a workshop-based methodology that focuses on the everyday person’s ability to share aspects of their life story. Over the course of a 5-day intensive workshop, DST participants are given the opportunity and skill necessary to produce a 2-4 minute video story. The focus of the workshop is on the skill-building process, not the end product. The beauty in the process is that it is grounded in storytellers’ ultimate control over the medium – words, images and audio – so stories are told by those who lived the experience. The methodology was developed in the mid 1990s in San Francisco, U.S.A., by the Center for Digital Storytelling. Since that time, it has been adopted by many organizations and individuals looking to give voice to the people and stories not often heard.

The workshop does not require previous experience as the process introduces and familiarizes storytellers with the use of software application programmes that are free or already packaged with a computer/laptop in order to put together a digital story.

Why Are We Doing This?
Women Win believes that DST has a unique ability to cultivate leadership potential. Through the process, young women are encouraged to strengthen muscles in all six competencies of leadership. Once you learn the skills needed to share your story through DST it becomes your responsibility to share those skills with your organisation, capturing more stories and multiplying the effect of the tool. The ultimate goal with DST is to strengthen our partners’ capacities to build girls’ leadership and communicate the impact of the work they do locally and globally. Women Win believes the stories of how sport affects your life are best told by you. We believe in the power of your story and your remarkable ability to share and create that story in a way no one else can. By raising your voice and telling your story, you have the chance to say what you want to say, exactly how you want to say it.

You will be creating your own short film about you!
Laptops
It is best to bring your own laptop to the workshop, if you have one or your organisation has one then will lend. If you don’t have access to one, please don’t worry. We will make sure everyone has access to one at the workshop.

IMPORTANT: If you are bringing your own laptop or a laptop belonging to your organisation, there are three computer programmes, or software applications, that are helpful to download before you come to the workshop. If you have any problems, do not worry. We can always help when you arrive.

Software
MovieMaker or iMovie: Most laptops come with a movie-making programme already installed under Applications. PCs will have MovieMaker. Macs will have iMovie. Please confirm that your laptop has the appropriate program installed.

Audacity: http://audacity.sourceforge.net/
This is a sound editing software application. Please choose the most appropriate and latest version depending on whether you use a PC or a Mac and your operating system. If in doubt, wait until you get to the workshop.

Gimp: http://www.gimp.org/downloads/
This is an image editing software application. If you do not have one already, please download the most recent version.

What to Bring:
1. Your story script of about 250 words
2. Photographs of yourself or any images (including drawings), letters, documents you feel will illustrate your story. If you intend to use photographs that are of friends or family members, it is best to get their permission first.
3. You are encouraged to have at least 25 digital images. Do not reduce the resolution until you have to use them during the workshop. But, do bring your photographs, images, drawings etc.
4. Meaningful items from home
5. Your digital camera (if you have one)
6. Your laptop (if you have access to one)
7. our earphones (if you have a pair)
8. A USB memory drive (if you have one)
9. Your energy and enthusiasm!

What to Avoid:
• Commercial music, that is to say music taken from a published CD / DVD / vinyl record or cassette tape.
• Photos taken by anyone other than you, your family or friends.
• Photos or clips of other people’s children (under 18 years of age).
• Company brands and logos such as Nike, Adidas, Coca Cola etc.
• Photos taken by anyone other than you, your family or friends.
• Photos or clips of other people’s children (under 18 years of age).
• Company brands and logos such as Nike, Adidas, Coca Cola etc.

Despite there being a wide variety of software suitable for accomplishing tasks in DST, Women Win chose this software suite because Audacity, GIMP and MovieMaker are free, easily accessible and simple for elementary users to learn.

Recommended websites for copyright-free images are:
http://www.flickr.com/creativecommons/
http://www.sxc.hu/
http://www.freeimages.co.uk/
http://www.public-domain-photos.com/
http://public-photo.net/
http://www.reusableart.com
http://www.freefoto.com/index.jsp

Recommended websites for copyright-free music:
http://www.royaltyfreemusic.com/
free-music-resources.html
http://www.openmusicarchive.org
Your Story + Script
The stories we create will be 2-4 minutes in length. They are typically told in the first person voice, using “I” and “me.” Your script will become the narration or ‘voice-over’ for your story. This means that you will read and record the story you have written using a microphone or digital audio recorder during the workshop. It should be around 250 words. Stories must be written in <insert language> and mention if the stories will be subtitled or not.

Prior to arrival in <insert name>, you must have a first draft script of your story written. The following prompts are meant to guide but not limit your story:

• What is the meaning of sport in your life? How has it impacted your leadership?
• What do you hope to accomplish with this story? What is your objective/goal for telling it?
• Who is your target audience (other leaders, young girls, local, national, global, decision makers?)
• What kind of story is this - Is this a comedy? A sad story? A drama? A tale of adventure?
• What was the moment when you first realized you were a leader? What triggered your experience? How did others react to you?
• What was the most pivotal, extreme, empowering, disempowering experience of your life and how did it shape your view?
• Why are you involved in the work that you do? How did this journey start? How has this journey been for you? Any particular fears, disappointments, losses, gains, achievements?
• Any particular key turning point?
• What stood in your way?
• What is your most poignant victory – on the sports field or in life?
• What other parts of your life have changed through your work, your sport?
• What drives you?
• What are your visions/goals/challenges?

Often times, DST participants tell very emotional stories of their lives. It’s part of the power of this process. Please write a story that you are comfortable sharing with others as that is a mandate of this workshop.

Some Story Writing Tips:
• Have a hook -- Start in the action
• Plan your story starting with the takeaway message
• Develop characters with detail, yourself included
• Try to stay in a specific (or a few specific) moments in time. 3 minutes is too short to tell a whole life story from birth to mid life.
• Have some stakes
• Less is more: be concise
• Think about building to an emotional high-point at about 70% of the way through your story
• Avoid ranting or preaching
• Try to have a conclusion of sorts at the end, avoid open, meandering endings.

Where to Send Draft Scripts
If you’d like feedback on your script or story ideas prior to the workshop, please send your draft by <Insert date>, to <insert name and e-mail address>.

Your Images and Photographs
Start taking pictures and videos now that will help tell your story! Remember once you arrive, you may not be able to return home to capture those scenes. Begin to think about which images - photographs and video - that might help tell your story along with the words you write. The pictures you use for your digital story can be anything you feel will illustrate the words of your script.

Hopefully you have the opportunity to practice with a digital camera. Be sure to take photographs or videos of anything that is important to or your story.

If you are a talented artist, consider creating a piece for your film. You can bring it or photograph it. You can also bring other drawings or choose to do some at the workshop. You can bring documents, like a birth certificate, or other papers that are important to your story and we could photograph them. You can bring photos of your home or workplace, or photos from the past that you might have in an album.

IMPORTANT: If you are in doubt, bring it – you can’t go home and fetch it once you are at the workshop! We will discuss the use of these photographs and videos so don’t worry. Just keep taking pictures or shooting video!

Other Images
Sometimes you may want to use images that symbolize something or to create a mood of sorts (such as nature, etc.). If you want to use images that are drawn or illustrated by others, it is best that you use copyright-free images.

Sounds: Music and Effects
Stories will be enhanced with music and sound effects. You may bring music from home – perhaps music that reflects a theme in your story, or music that emphasizes your cultural or traditional background. Maybe you sing or play an instrument. Record it on your camera or a digital recorder. We will not be using any commercial music that is rights-managed, so please do not bring professional music that you do not have the rights to use.
Participant Skills Self Assessment

Please complete the following survey. Your answers will help us to better understand how best to prepare the digital storytelling workshop, both for your technical training as well as which equipment we will need to arrange. Remember, no previous experience is required nor do you need to have your own laptops, etc. Completing this questionnaire will also give you a chance to reflect on the skills that you will have the chance to develop during the DST workshop and that will need as a successful future DST facilitator!

Section 1. About You
1.1. What is your first name?
1.2. What is your surname?
1.3. What is your date of birth?
1.4. What is your organisation?

Section 2. Your personal objectives of this workshop
2.1. Why are you interested in participating in this digital storytelling workshop? What would you like to gain?
2.2. What story you would want to share and why?
2.3. What is the key message of your story?
2.4. What is the audience of your story?

Section 3. Leadership
3.1. Do you consider yourself as a leader? Why?
3.2. According to you, what are the main qualities and characteristics of a good leader?
3.3. What do you think are your current strengths as a leader?
3.4. Which leadership qualities do you see as a need to improve?

Section 4. Digital Storytelling – Information and Communication Technology (ICT)

4.1. GENERAL COMPUTER SKILLS
   a. Have you used a computer before? YES/NO - If NO, please continue with Sub-section 4.2. AUDIO.
   b. Is the computer you normally work on a PC or a Mac? PC/Mac
   c. Have you used a computer for typing word documents? YES/NO
   d. Do you know how to organize files in folders and sub-folders on a computer? YES/NO
   e. Do you know how the location of files relates to video/movie making creation? YES/NO.
   f. Have you ever taught others about how to use a computer? YES/NO
   g. Have you used the Internet to look for information? YES/NO - If NO please continue with Sub-section 4.2. AUDIO.
   h. Have you ever searched the Internet for images? YES/NO
   i. Have you ever searched the Internet for audio clips or music? YES/NO

4.2. AUDIO
   a. Have you ever recorded your voice or the voice of someone else using a microphone or a digital voice/audio recorder before? YES/NO
   b. Have you ever edited audio before? YES/NO - If NO please continue with Sub-section 4.3. IMAGES.
   c. What software(s) have you used? O Audacity O Other __________
d. Have you ever taught others how to edit sound? YES/NO
   - If NO please continue with item “f” below.

e. What software(s) have you used to teach others?
   O Audacity      O Other __________

f. Have you ever used Audacity to edit sound? YES/NO - If NO please continue with
   Sub-section 4.3. IMAGES.

g. What is your experience with the following Audacity features? Please choose (1-4).
   i. Highlighting Audio
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   ii. Zoom
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   iii. Effects/Amplify
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   iv. Time Shift Tool
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   v. Scissors
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   vi. Copy/Paste
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   vii. Panning/Volume
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   viii. Envelope
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   ix. Adding a new layer
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.

   x. Adding silence
      1) I don’t know what this is.
      2) I know what this is but I have never used it before.
      3) I’ve used it before but I’m not very comfortable using it.
      4) I’m very comfortable using this tool.
xi. Fade effects
1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.

4.3. IMAGES
a. Have you ever taken any digital photographs? YES/NO

b. Have you ever edited digital photographs or images before? YES/NO - If NO please continue with Sub-section 4.4. MOVIE MAKING.

c. What software(s) have you used? O GIMP O Other ________________

d. Have you ever taught others how to edit photographs or images? YES/NO - If NO please continue with item “f” below.

c. What software(s) have you used to teach others? O GIMP O Other ________________

e. Have you ever used GIMP to edit photographs or images before? If NO please continue with Sub-section

g. What is your experience with the following GIMP features? Please choose (1-4).

i. Identifying image size and resolution
1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.

ii. Image scale: resizing an image
1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.

iii. Cropping with Rectangle Select (Fixed Size)
1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.

iv. Zooming in/out
1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.

v. Rotating an image
1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.

vi. Blurring with Ellipse/Filter/Gaussian Blur
1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.

vii. Color/Color Balance
1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.
**Vi. Exporting**

1) I don’t know what this is.
2) I know what this is but I have never used it before.
3) I’ve used it before but I’m not very comfortable using it.
4) I’m very comfortable using this tool.

**4.4. MOVIE MAKING**

a. Have you ever made a film using a computer before? YES/NO - If NO please continue with Sub-section 5.1. STORYTELLING SKILLS.

b. What software(s) did you use? O MovieMaker  O iMovie  O Other _____________

c. Have you ever taught others how to make a film using a computer? YES/NO - If NO please continue with item “f” below.

d. What software(s) have you used to teach others? O MovieMaker  O iMovie  O Other _____________

e. Have you ever made a film using MovieMaker or iMovie before? YES/NO - If NO please continue with Sub-section 4.5. CREATIVE COMMONS.

f. What is your experience with the following MovieMaker or iMovie features? Please choose (1-4)

i. Adding, dragging, copying, deleting, sound segments/pictures, saving
   1) I don’t know what this is.
   2) I know what this is but I have never used it before.
   3) I’ve used it before but I’m not very comfortable using it.
   4) I’m very comfortable using this tool.

ii. Changing time duration of frame
   1) I don’t know what this is.
   2) I know what this is but I have never used it before.
   3) I’ve used it before but I’m not very comfortable using it.
   4) I’m very comfortable using this tool.

iii. Visual effects, such as blurring, edge detection etc.
   1) I don’t know what this is.
   2) I know what this is but I have never used it before.
   3) I’ve used it before but I’m not very comfortable using it.
   4) I’m very comfortable using this tool.

iv. Adding subtitles or text to frames
   1) I don’t know what this is.
   2) I know what this is but I have never used it before.
   3) I’ve used it before but I’m not very comfortable using it.
   4) I’m very comfortable using this tool.

v. Lining up audio with visuals
   1) I don’t know what this is.
   2) I know what this is but I have never used it before.
   3) I’ve used it before but I’m not very comfortable using it.
   4) I’m very comfortable using this tool.

vi. Creating transitions between frames
   1) I don’t know what this is.
   2) I know what this is but I have never used it before.
   3) I’ve used it before but I’m not very comfortable using it.
   4) I’m very comfortable using this tool.

vii. Exporting video
   1) I don’t know what this is.
   2) I know what this is but I have never used it before.
   3) I’ve used it before but I’m not very comfortable using it.
   4) I’m very comfortable using this tool.

**4.5. CREATIVE COMMONS**

a. I know what Creative Commons licensing is. YES/NO
Section 6. Digital Storytelling - Facilitation Skills

6.1. FACILITATION SKILLS

a. Have you ever facilitated any kind of workshop, sports session, life skills session or event? YES/NO – If NO, please continue with Section 7. Your Equipment.

b. Regarding your facilitation skills, please state how you feel about the ideas below. Mark whether you strongly disagree, disagree, agree or strongly agree.

i. I prepare thoroughly before delivering a workshop.
   O Strongly Disagree O Disagree O Agree O Strongly Agree

ii. I can manage time effectively.
   O Strongly Disagree O Disagree O Agree O Strongly Agree

iii. I can evoke participation and creativity.
   O Strongly Disagree O Disagree O Agree O Strongly Agree

iv. I am skilled and confident in orchestrating the event.
   O Strongly Disagree O Disagree O Agree O Strongly Agree

v. I can use and overcome obstacles that appear in a creative and constructive way.
   O Strongly Disagree O Disagree O Agree O Strongly Agree

vi. I give feedback that affirms the wisdom of the group.
   O Strongly Disagree O Disagree O Agree O Strongly Agree

vii. I assume responsibility for the group and the process.
   O Strongly Disagree O Disagree O Agree O Strongly Agree

viii. I can read the underlying dynamics in the group.
     O Strongly Disagree O Disagree O Agree O Strongly Agree

ix. I maintain objectivity, boundaries and personal integrity.
     O Strongly Disagree O Disagree O Agree O Strongly Agree

x. I can produce efficient documentation identifying successes, challenges and ways to improve.
    O Strongly Disagree O Disagree O Agree O Strongly Agree

Section 7. Your Equipment

1. Do you have headphones that you can bring? YES/NO
2. Do you have a digital camera that you can bring? YES/NO
3. Do you have a flash drive/USB stick you can bring? YES/NO
4. Are you planning to bring your own laptop or the laptop from the organisation? If yes, please continue with the survey. If no, the survey is complete. Thank you. YES/NO
5. Does your laptop have a DVD writer? YES/NO
6. Is your laptop able to connect to wireless Internet? YES/NO
7. Do you run an anti-virus programme on your laptop? YES/NO
8. If yes, please state which one and the last time you ran the anti-virus programme.
9. Does your laptop have Windows Movie Maker (for PC) or iMovie (for Mac)?
10. Does your laptop have a soundcard? YES/NO

We really appreciate your time to complete this survey! Thank you and we look forward to having you in the workshop!
WORKSHOP DAY 1
INTRODUCTION TO DIGITAL STORYTELLING
Introduction to Digital Storytelling

Objectives/ Outcomes of the Day

Thematic Objectives
• Understand the overarching objectives of the DST workshop and the process
• Understand the pedagogic teaching behind constructing a story

Practical Objectives
• Understand the workshop agenda including requirements for individual participation
• Begin to develop the circle of trust
• Establish group-defined rules of participation and expectations of one another as well as facilitators
• Comprehend the elements and key features of a digital story
• Understand story script construction
• Ensure laptops/computers have internet access, updated anti-virus applications and the necessary software downloaded

Outcomes
• Group’s rules of participation are defined and fully understood by all
• Full comprehension of DST, the workshop agenda and process
• Solid understanding of a digital story and its encompassing elements
• Inspiration for advancement of personal scripts

Tasks
• Develop scripts, 250 words, and print (double line spacing, 14 to 16 pt size)
• Ensure laptops/computers have access to internet, up-dated antivirus and installed applications
• Begin to consider and identify target audiences and tools to reach those audience groups

Main Activities
• Icebreaker
• Presentation: Introduction to DST
• Presentation: Review of the week’s agenda
• Getting to Know Each Other
• Presentation: Elements of a Digital Story
• Presentation: Art of Storytelling
• View DST examples

HOMEWORK ASSIGNMENT: DAY 1
✓ All participants must arrive to the next morning with a draft script, prepared to read to the group.
✓ The script should be as in final form as possible, approximately 250 words.
✓ Participants should prepare any comments, questions or specific points for feedback request.

Facilitator Tips: Day 1
• Creating an open, safe environment is critical to the success of the workshop. Consider how you will cultivate that kind of space even if the participants are familiar with one another
• For efficiency, over-emphasise the need for a lean word count and keeping up with the pace of the workshop
• You may need to make yourself available in the evening to help participants narrow their story and draft scripts.
## Schedule Day 1

<table>
<thead>
<tr>
<th>TIME</th>
<th>ITEM</th>
<th>SUPPORTING MATERIAL</th>
</tr>
</thead>
</table>
| 9:00–10:00 | • Welcome and Background  
• Introduction  
• Icebreaker  
• What is DST and why are we doing it? | PPT – Welcome to Digital Storytelling                     |
| 10:00–10:30| Logistics  
Broad overview of week, logistics, other announcements |                                                           |
| 10:30–10:45| MORNING COFFEE/TEA BREAK                                             |                                                           |
| 10:45–11:30| Getting to Know Each Other                                           | Group Energiser: i.e. Two Truths and One Lie             |
| 11:30–13:00| • Equipment Check  
• Confirm laptops, internet, software  
• Work on scripts |                                                           |
| 13:00–14:00| LUNCH BREAK                                                         |                                                           |
| 14:00–14:30| Expectations Check & Rules of Participation                         | Group activity: Group creates list                        |
| 14:30–16:30| Introduction to Digital Stories  
• What is a digital story?  
• Elements of a digital story  
• Art of storytelling  
• View DST examples, discuss | PPT – Elements of a Digital Story and The Art of Storytelling  
DST video samples and links  
Handout: Sample Scripts |
| 16:30–17:00| Wrap up: Day 1  
• Review Programme for Day 2  
• Tasks for the day: Drafting of script  
• Communication & Distribution – Introduction to Share Plan |                                                           |
DST Examples

Showing examples of digital stories is an inspiring way to help participants understand the process and spark their creativity. It adds dimension to their knowledge of what works and what doesn’t work from a viewer perspective.

It also helps them begin to visualise their own stories. After showing each example, ask the young women for their own reflections and thoughts, being sure to highlight the key elements of each story.

<table>
<thead>
<tr>
<th>STORYTELLER</th>
<th>TITLE</th>
<th>LINK</th>
<th>THEME</th>
<th>KEY ELEMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymous</td>
<td>A Stonecutter in Kinkala</td>
<td><a href="https://www.takebackthetech.net/ds/stonecutter-kinkala">https://www.takebackthetech.net/ds/stonecutter-kinkala</a></td>
<td>Pride in self; armed conflict</td>
<td>• Mix of visual elements: still, drawings, video</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• How are war images drawn, what does this add?</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Still proud of something from her past</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Stonecutter circle of story empowerment</td>
</tr>
<tr>
<td>Cindy Liou</td>
<td>Untitled</td>
<td><a href="https://www.takebackthetech.net/ds/cindy-liou">https://www.takebackthetech.net/ds/cindy-liou</a></td>
<td>GBV, self-empowerment</td>
<td>• Linking past to present</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Her story via her friend’s story</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Use of black screen – a pause, a change</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Circular image story</td>
</tr>
<tr>
<td>Nicole Matuksa</td>
<td>Becoming Nicole</td>
<td><a href="http://womenwin.org/stories/digital-storytelling-project/watch-videos/becoming-nicole">http://womenwin.org/stories/digital-storytelling-project/watch-videos/becoming-nicole</a></td>
<td>Sport and self-acceptance</td>
<td>• Story style and entry point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Use of music, visuals</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Alignment of script</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Voice clarity</td>
</tr>
<tr>
<td>Coredo</td>
<td></td>
<td></td>
<td></td>
<td>• Use of visuals, mix</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• metaphor</td>
</tr>
<tr>
<td>Amrita Bisht</td>
<td>No Girl, No Boy, I am a Sportsperson</td>
<td><a href="http://womenwin.org/stories/digital-storytelling-project/watch-videos/no-girl-no-boy-i-am-a-sportsperson">http://womenwin.org/stories/digital-storytelling-project/watch-videos/no-girl-no-boy-i-am-a-sportsperson</a></td>
<td>Sport overcoming societal norms</td>
<td>• Message of story, tone</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Story script, tight</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Use of visuals, mix</td>
</tr>
<tr>
<td>Linda Chouern</td>
<td>Football Saved My Life</td>
<td><a href="http://womenwin.org/stories/digital-storytelling-project/watch-videos/football-saved-my-life">http://womenwin.org/stories/digital-storytelling-project/watch-videos/football-saved-my-life</a></td>
<td>Sport as a way out</td>
<td>• Use of voice, low and high points</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Story script, clear storyline,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Suspense</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Personalisation of sport</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Change in tone, pace</td>
</tr>
</tbody>
</table>
WORKSHOP
DAY
2
THE ART OF STORYTELLING
Objectives/Outcomes of the Day

The Art of Storytelling:
Thematic Objectives
• Able to create a compelling story script
• Able to define target audience groups and develop appropriate purpose, message and objective for each group
• Able to organise advanced file saving system

Practical Objectives
• Able to write and edit own script
• Able to create a complete storyboard based on the script
• Comprehension of ethical guidelines, copyright, Creative Commons license and consent
• Able to identify key considerations in relation to intended audiences for digital stories and how to share or distribute these digital stories

Outcomes
• Gain valuable insight to refine and finalise script
• Development of a storyboard based on script and time
• Solid understanding to ethical guidelines, copyright, consent and ownership
• Ability to think critically through developing and delivering messages to defined audience groups

Tasks
• Finalise script
• Finalise storyboard
• Begin to select visuals
• Complete Share Plan

Main Activities
• Story circle
• Presentation: Storyboard
• Establish standard system to organise and save files
• Group activity: Sharing with Our Audiences
• Presentation: Ownership and Consent

FACILITATOR TIPS: DAY 2
• Create a space for story circle that is safe from outside interruption
• Encourage participants to actively listen to one another during the story circle
• Emphasize the importance of the storyboard, it is easily forgotten but critical for time efficiency
• Consent Form: Be sure that every participant understands the consent form before they sign it

HOMEWORK ASSIGNMENT: DAY 2
✓ All participants must arrive to the next morning with a final script, ready to record, a final storyboard and a complete share plan.
✓ Participants should practice reading their script to explore pace, voice fluctuation and emotion.
✓ Participants should prepare any comments, questions or specific points for feedback request.
## Schedule Day 2

<table>
<thead>
<tr>
<th>TIME</th>
<th>ITEMS</th>
<th>SUPPORTING MATERIALS</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00–9:15</td>
<td>Welcome! Programme for the Day</td>
<td></td>
</tr>
<tr>
<td>9:15–11:15</td>
<td>Story Circle</td>
<td></td>
</tr>
<tr>
<td>11:15–11:45</td>
<td>MORNING COFFEE/TEA BREAK</td>
<td></td>
</tr>
<tr>
<td>11:45–12:15</td>
<td>Storyboarding</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The art of a storyboard and its evolution</td>
<td>Group activity: practice with images Day 2 PPT</td>
</tr>
<tr>
<td></td>
<td>How to keep a storyboard</td>
<td></td>
</tr>
<tr>
<td>12:15–13:00</td>
<td>Production Schedule</td>
<td>Handout: Production Schedule</td>
</tr>
<tr>
<td></td>
<td>File Organisation and Saving</td>
<td>Day 2 PPT: File Organisation</td>
</tr>
<tr>
<td>13:00–14:00</td>
<td>LUNCH BREAK</td>
<td></td>
</tr>
<tr>
<td>14:00–14:45</td>
<td>Audience and Share Plan</td>
<td>Group activity: split to smaller groups, each group creates a mega-message, identifies target audience groups, direct messages to each group</td>
</tr>
<tr>
<td></td>
<td>Why and how do we define our audiences</td>
<td></td>
</tr>
<tr>
<td></td>
<td>How does our message and tools change to reflect audiences</td>
<td></td>
</tr>
<tr>
<td>14:45–15:30</td>
<td>Ownership of Stories</td>
<td>Day 2 PPT: Ownership &amp; Consent</td>
</tr>
<tr>
<td></td>
<td>Clarification on ownership and consent</td>
<td>Hand-out: Consent forms</td>
</tr>
<tr>
<td></td>
<td>Permissions (CC): What is Creative Commons?</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Communication channels/liaison with Women Win</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Process to withdraw consent, and explanation of consent form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>How will the digital stories be used and intended audiences</td>
<td></td>
</tr>
<tr>
<td>15:30–16:45</td>
<td>Individual Work</td>
<td>Offer feedback on scripts, storyboards, share plans, consent forms as needed</td>
</tr>
<tr>
<td></td>
<td>Finalise scripts</td>
<td>Collect share plans, consent forms</td>
</tr>
<tr>
<td></td>
<td>Begin and finalise storyboards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Finalise Share Plans</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Begin to select images</td>
<td></td>
</tr>
<tr>
<td>16:45–17:00</td>
<td>Wrap up: Day 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Production schedule</td>
<td></td>
</tr>
</tbody>
</table>
The DST workshop is a creative process that requires edits, revisions, reworks, media collection, etc. It is imperative that participants are instructed and continually reminded to frequently save their work! We suggest creating a standardised folder-file structure that each participant replicates on their desktop to organise and save all relevant files, such as the one below.

The voice over file should be a final edited version of the script read aloud only, without any music in the background. These two folders, Voiceover only and Final Audio, will each have two files in them: one as the saved .aup file, the other as the exported .wav file.
A production schedule is used to keep a daily pulse on exactly where each participant is in the film development process. It’s critical to stay on track and make sure participants are accountable for completing assignments on time. Create a LARGE chart like the one below and put it on a wall to track progress. After the completion of each step, participants should receive approval from a facilitator and check the box.

TOP TIP: GROUP ACTIVITY FOR AUDIENCE
It’s a great idea to divide the group into smaller groups and task each group with developing a mega-message, i.e. Girls must be allowed to play sport. Then have them identify five different audience groups, a targeted message, objective and best tool for reaching each audience.
## Production Schedule

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**SHARE PLAN TEMPLATE**

<table>
<thead>
<tr>
<th>AUDIENCE</th>
<th>METHOD/TOOLS</th>
<th>TIMELINE</th>
<th>OBJECTIVE</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Storyteller Name:** ____________________________  **Length of Story:** ____________________________

**Working Film Title:** ____________________________  **Film Message:** ____________________________

**Mission for film:** ____________________________
Ownership of Digital Story
1. Storytellers have the right to freedom of expression in representing themselves in their stories.
2. Storytellers can and are encouraged to determine where, why, and how their stories will be distributed.
3. Storytellers have the right to determine whether or not their names are attached to their stories and whether images of themselves / others are to be blurred to protect privacy.

IMPORTANT: All Women Win digital stories have a creative commons licence that allows for modifications, sharing and further distribution as long as the owner of the digital story, the workshop organiser, and other consented parties are duly acknowledged.

CONSENT TO CONDITIONS OF USE

PART 1: CLARIFICATION OF TERMS AND ATTRIBUTION

(Story title):

was produced by:

during a Digital Storytelling workshop in (insert location)

from (dates)

facilitated by (insert organisation)

Storyteller’s Name or Pseudonym:

Home organisation:

Postal Address:

Phone number(s):

E-mail address:
CONSENT TO CONDITIONS OF USE

PART 2: CLARIFICATION OF USE AND DISTRIBUTION

USAGE

I give consent for my digital story, titled

and developed at a Digital Storytelling workshop facilitated by [organisation name]
on the (date)

...to be used in the ways identified below. (Check ONE of the answers below, 1, 2 or 3)

☐ 1. My digital story can be shared freely – posted online, used by the host organisations and distributed to third party stakeholders such as funding organisations or those interested in Digital Storytelling. (Note: this level of consent assumes your story will have a Creative Commons attribution, non-commercial share alike license)

☐ 2. My digital story can ONLY be used by the following organisations for non-profit purposes (circle ALL that apply):

   - Women Win (including posting the story on the WW DST web platform)
   - My organisation
   - Others attending this workshop

☐ 3. I do not give consent for my story to be used in any way.

Signed by Storyteller:

Date:
WORKSHOP DAY

3

CREATING SOUND
Objectives/
Outcomes of the Day

Creating Sound:
Thematic Objectives
• Able to record, import and edit sound

Practical Objectives
• Able to record own voice based on a finalised script
• Able to record ambient noise and sound effects
• Able to search for, download and import royalty-free music and sound effects
• Able to identify appropriate credits for music and sound effect artists
• Able to merge voice, music and sound effects in Audacity
• Able to create and edit full audio track in Audacity
• Comprehend audio spectrum, and how to amplify and reduce sound levels on different tracks

Main Activities
• Presentation: Sound, Recording & Editing
• Record voiceover
• Edit final voiceover
• Edit final audio, supplemented with music and sound effects
• Refining storyboard and continue selecting visuals

Outcomes
• Gain valuable insight to refine and finalise script
• Development of a storyboard based on script and time
• Solid understanding to ethical guidelines, copyright, consent and ownership
• Ability to think critically through developing and delivering messages to defined audience groups

Tasks
• Finalise audio
• Update storyboard
• Visuals selection

FACILITATOR TIPS: DAY 3
• Make sure the recording space is sound-proof. Background noise cannot be fixed.
• Having participants hold the microphone or recording device often helps lift their voices during recording.
• Participants tend to keep music levels too loud, which drowns out their scripts. Consider a peer audio approval system, where pairs listen to one another’s tracks.
• Mobile phones may save audio recording files in a format that is not supported by Audacity or MovieMaker. Use an online converter to convert the audio files into .MP3 or .WAV file types.

HOMEWORK ASSIGNMENT: DAY 3
✓ All participants must arrive to the next morning with a final edit voiceover only and final audio track.
✓ Participants with extra time should search and gather images.
## Schedule Day 3

<table>
<thead>
<tr>
<th>TIME</th>
<th>ITEMS</th>
<th>SUPPORTING MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00–9:30</td>
<td>Welcome and Production Schedule – Where are we?</td>
<td></td>
</tr>
<tr>
<td>9:30–10:00</td>
<td>Tutorial – The Role of Sound</td>
<td>Day 3 PPT</td>
</tr>
<tr>
<td></td>
<td>Why sound, types and use</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• How to record</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Downloading sound effects and music</td>
<td></td>
</tr>
<tr>
<td>10:00–11:30</td>
<td>Individual Work</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Record story and download file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Update storyboards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Search and select sound, music</td>
<td></td>
</tr>
<tr>
<td>10:30–10:45</td>
<td>WORKING MORNING COFFEE/TEA BREAK</td>
<td></td>
</tr>
<tr>
<td>11:30–12:30</td>
<td>Tutorial – Sound Editing (Audacity)</td>
<td>Day 3 PPT</td>
</tr>
<tr>
<td></td>
<td>• How to import</td>
<td>Demonstrate Audacity</td>
</tr>
<tr>
<td></td>
<td>• Getting familiar with Audacity</td>
<td>Hand-out: Audacity</td>
</tr>
<tr>
<td></td>
<td>• Editing techniques</td>
<td>Cheat Sheet</td>
</tr>
<tr>
<td>12:30–13:00</td>
<td>Individual Work</td>
<td>One-on-One assistance</td>
</tr>
<tr>
<td></td>
<td>• Record story and download file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Import story to Audacity and begin editing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Search and select sound, music</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Revise storyboards as needed</td>
<td></td>
</tr>
<tr>
<td>13:00–14:00</td>
<td>LUNCH BREAK</td>
<td></td>
</tr>
<tr>
<td>14:00–16:30</td>
<td>Individual Work</td>
<td>One-on-One assistance</td>
</tr>
<tr>
<td></td>
<td>• Finish editing script with sound effects and music</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Search and select images</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Revise storyboards as needed</td>
<td></td>
</tr>
<tr>
<td>16:30–17:00</td>
<td>Wrap up: Day 3</td>
<td>Wrap up: Day 3</td>
</tr>
</tbody>
</table>
Objectives/Outcomes of the Day

Visuals:
Thematic Objectives
• Comprehension of pedagogic approach to visual selection
• Select, import and edit images

Practical Objectives
• Able to select compelling, usable images from personal collections as well as internet sources
• Able to resize images and adjust resolution
• Able to edit images in Gimp, performing such functions as crop, blur and shadow
• Able to create an end credit image

Outcomes
• Gain knowledge related to ‘good’ image selection
• Comprehension of image resolution and size
• Ability to import, resize and edit images
• Ability to create an end-credit screen with organizational logos

Tasks
• Select and import all images
• Resize, edit and finalise all images
• Create an end credit image

Main Activities
• Presentation: Selecting and Editing Images
• Select and import all images to Gimp
• Resize, adjust resolution and edit images to final form
• Create end-credit image (this may be one common image, shared with the group)

TOP TIP: MISSING IMAGES
When participants are missing photos to tell their story, Women Win strongly encourages participants to self-create images – drawing, painting, sculpting, etc. – rather than downloading images from the Internet. Have supplies on-hand to enable the creativity!

FACILITATOR TIPS: DAY 4
• Remind participants of the importance of connecting the visuals to the script, why will it make sense for the audience to see that?
• Encourage self-created art rather than using images from the Internet
• Have the young women keep a running list of the photographers for any images they download from the Internet

HOMEWORK ASSIGNMENT: DAY 4
• All participants must arrive to next morning with all images selected, imported, resized and edited in final form.
• The total number of images should correspond to the participants’ storyboards and duration of scripts.
• The end-screen credit image may be an image shared by the group.
## Schedule Day 4

<table>
<thead>
<tr>
<th>TIME</th>
<th>ITEMS</th>
<th>SUPPORTING MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00–9:30</td>
<td>Welcome and Production Schedule – Where are we?</td>
<td></td>
</tr>
<tr>
<td>9:30–11:00</td>
<td>Tutorial – Image Selection &amp; Resolution</td>
<td>Day 4 PPT</td>
</tr>
<tr>
<td></td>
<td>• What makes an image ‘good’?</td>
<td>Links for free images (see preparation document)</td>
</tr>
<tr>
<td></td>
<td>• What is resolution, size and why does it matter?</td>
<td>Demonstrate Gimp</td>
</tr>
<tr>
<td></td>
<td>Image Editing</td>
<td>Hand-out: Gimp cheat sheet</td>
</tr>
<tr>
<td></td>
<td>• Gimp: resizing, cropping, blurring</td>
<td></td>
</tr>
<tr>
<td>11:00–11:15</td>
<td>MORNING COFFEE/TEA BREAK</td>
<td></td>
</tr>
<tr>
<td>11:15–13:00</td>
<td>Individual Work</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Search, select, import images</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Edit Images</td>
<td></td>
</tr>
<tr>
<td>12:00–13:00</td>
<td>Credit Screen</td>
<td>Group work</td>
</tr>
<tr>
<td></td>
<td>• Why we use it</td>
<td>Distribute common shared end credit frame</td>
</tr>
<tr>
<td></td>
<td>• How to make one</td>
<td></td>
</tr>
<tr>
<td>13:00–14:00</td>
<td>LUNCH BREAK</td>
<td></td>
</tr>
<tr>
<td>14:00–16:45</td>
<td>Individual Work</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Finish selecting, editing images</td>
<td></td>
</tr>
<tr>
<td>16:45–17:00</td>
<td>Wrap up: Day 4</td>
<td></td>
</tr>
</tbody>
</table>
MOVIE MAKING

WORKSHOP DAY

5
Objectives/
Outcomes of the Day

Movie Making:
Thematic Objectives
• Able to create a video
• Discuss an effective ‘What’s Next’ plan
• Self-reflection and group learnings

Practical Objectives
• Able to craft a final film with use of frame transitions and animations
• Able to build title and rolling end-credit screens
• Able to save, export a final film
• Draft personal bio and film teaser
• Gain insight into the learnings of the DST tool and methodology through self-reflection and group discussion

Main Activities
• Presentation: Movie Making!
• Craft a final film
• Save and export films and files
• Group activity: Reflection

Outcomes
• Comprehensive ability to craft a compelling video story
• Solid understanding of movie export process
• Ability to think critically about the methodology of the DST workshop as well as self-reflect on the process

Tasks
• Finalise films
• Complete workshop evaluation
• Collect consent forms
• Collect movie and supporting folder files

FACILITATOR TIPS: DAY 5
• This day is more about individual help, less about teaching. Each participant will have specific questions related to her unique project
• It is critical that participants import audio and visual into MovieMaker from saved files on their hard drives, not USBs!
• Consider creating a closing credit screen in advance that you circulate to all participants
• Export files as .MP4, MovieMaker automatically adjusts specs for optimal settings, which should be 1920x1080p.
## Schedule Day 5

<table>
<thead>
<tr>
<th>TIME</th>
<th>ITEMS</th>
<th>SUPPORTING MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00–9:15</td>
<td>Welcome and Production Schedule – Where are we?</td>
<td></td>
</tr>
<tr>
<td>9:15–10:15</td>
<td>Tutorial: MovieMaker</td>
<td>Day 5 PPT</td>
</tr>
<tr>
<td></td>
<td>• Putting it all together</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Transitions, animations, fades</td>
<td></td>
</tr>
<tr>
<td>10:15–10:30</td>
<td>WORKING MORNING COFFEE/TEA BREAK</td>
<td></td>
</tr>
<tr>
<td>10:45–13:00</td>
<td>Individual Work – Putting it together, finalise films</td>
<td></td>
</tr>
<tr>
<td>13:00–14:00</td>
<td>LUNCH BREAK</td>
<td></td>
</tr>
<tr>
<td>14:00–15:00</td>
<td>Individual Work – Putting it together, finalise films</td>
<td></td>
</tr>
<tr>
<td>15:00–16:00</td>
<td>Exporting and saving films for distribution</td>
<td>Export and save to main hard drive</td>
</tr>
<tr>
<td></td>
<td>(Include scripts)</td>
<td>Girls to also save on personal USBs</td>
</tr>
<tr>
<td>16:00–17:00</td>
<td>Workshop Reflections and Feedback</td>
<td>Group activity: Discussion</td>
</tr>
<tr>
<td></td>
<td>• Identifying DST skills to share with others and how best to share these</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Conducting another DST workshop (workshop process)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• How did it feel to share your story? How do you want to share your story?</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• What are your plans? Identification of audiences</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Workshop Evaluation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Evaluation Forms</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Consent Forms</td>
<td></td>
</tr>
</tbody>
</table>

Hand-out: Evaluation forms
Collect Share Plans, Evaluation Forms, Consent Forms (give copy to participants) if have not already done
D. Tips for Reflections and Wrap-Up

One powerful aspect of a DST workshop is the ability to self-reflect on the process and gather key learnings from the group. Prior to an evaluation of the workshop but following an informal or formal film screening, conduct a discussion session to bring the workshop full circle.

Examples of questions to guide the discussion are below.

- What story did you choose to tell and why do think you chose this one?
- How did that story change throughout the workshop process? Why?
- What do you think you were attempting to highlight in your life? Why was this important to you?
- How did you feel to hear/see your story reflected back to you? What did you learn about yourself from this moment in time? Did this story affect future events in your life? How?
- Which other stories caught your attention and why?
- What did you learn from the collection of stories in this workshop?
- What were the strengths of the DST process for you? Weaknesses?
- How could the DST process benefit others?

The ability to self-reflect on the process
### Workshop Evaluation

<table>
<thead>
<tr>
<th>Item</th>
<th>Rating</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>Excellent</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>Good</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>Average</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>Poor</td>
</tr>
</tbody>
</table>

*Please provide your feedback on the workshop's content, delivery, and overall effectiveness.*
Workshop Evaluation

**WORKSHOP NAME:**

**TRAINING LOCATION:**

**DATE:** ........ / ........ / ........

**Optional**

**PARTICIPANT NAME:**

**ORGANISATION:**

**JOB TITLE:**

**INSTRUCTIONS**

Please rate aspects of the workshop on a 1 to 4 scale by checking one of the boxes:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>= Disagree strongly</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>= Disagree</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>= Agree</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>= Agree Strongly</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>= Not applicable (Choose N/A if the item is not appropriate or not applicable to this workshop.)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

We are very grateful for your honest feedback to help us improve. Thank you.

---

### WORKSHOP CONTENT

I was well informed about the objectives of this workshop:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This workshop lived up to my expectations:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The content is relevant to my organisation:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The content is relevant to my specific job:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

I understood the majority of the content of the workshop:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

### WORKSHOP DESIGN

The workshop objectives were clear to me

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The workshop activities stimulated my learning

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The activities in this workshop gave me sufficient practice and feedback

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The pace of this workshop was appropriate

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The workshop venue (meeting space and sleeping arrangements) were sufficiently comfortable

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

### WORKSHOP FACILITATOR

The instructor was well prepared and knowledgeable about the topics

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The instructor was helpful and responsive to my needs

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---
### WORKSHOP RESULTS

<table>
<thead>
<tr>
<th>Question</th>
<th>Rating</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>I accomplished the objectives of this workshop</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>N/A</td>
</tr>
</tbody>
</table>

| I learned new information and/or skills during this workshop             |        |          |
|                                                                          | 1      |          |
|                                                                          | 2      |          |
|                                                                          | 3      |          |
|                                                                          | 4      | N/A      |

| I will be able to use what I learned in this workshop                    |        |          |
|                                                                          | 1      |          |
|                                                                          | 2      |          |
|                                                                          | 3      |          |
|                                                                          | 4      | N/A      |

<table>
<thead>
<tr>
<th>The workshop was a good way for me to learn about empowering girls through sports</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### GENERAL

<table>
<thead>
<tr>
<th>Question</th>
<th>Rating</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do you have any recommendations for this workshop related to</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a) structure, time and schedule?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. What is most valuable (biggest learning) from this workshop?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Do you have an increased ability to tell your story? Yes/No. Please explain.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Have you increased your leadership skills? Yes/No. Please explain.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Hosting a DST Film Screening

Hosting a formal DST film screening with a public audience is a powerful way to celebrate the completion of the workshop. It raises the voices of the participants, allows them to experience the feel of sharing their stories to an audience, and often creates a magical, pride-filled moment for each participant. It also serves an excellent way to engage relevant partners and other audiences, for example local elected officials, community leaders, educators and religious leaders.

Below is an outline and timeline to assist in the planning process.

Four Weeks Prior
- Set the date
- Reserve a venue
- Make sure the venue can be sufficiently darkened
- Consider how many chairs it can accommodate
- Reserve the necessary equipment
- Sufficient sized screen for ample viewing or a large, clear wall
- Projector
- Speakers or sound system
- Microphone
- Cables
- Create an audience guest list, complete with contact information

Three Weeks Prior
- Create an invitation with RSVP date and distribute to the audience guest list
- Make arrangements for refreshments

One to Two Weeks Prior
- Confirm all arrangements for venue and equipment reservations
- Test equipment to ensure all is working properly
- Create and print a programme for the event, if possible, with list of filmmakers and movie titles
- Follow up with guests who have not RSVP’d as needed

One Day Prior
- Prepare the venue, making sure everything is in place
- Familiarise yourself with the equipment and room lighting controls
- Be sure chairs are arranged for optimal viewing
- Test the equipment
- Secure cables. Make sure loose cables are taped to the floor securely where people might sit or walk

Day Of
- Arrive early in case you encounter any surprises
- Double-check everything is in place and working
- Enjoy!

TOP TIP: RAISE HER VOICE

Have each participant introduce herself and her film prior to its viewing. A typical introduction would be 2-3 minutes in length and include a personal reflection on the DST process or her story, without talking about her specific story.
DST Workshop
Follow-up

After the success of your DST workshop, there are a few more steps to bring the workshop to complete closure.

Thank You E-mail to Participants
Facilitators should send participants an e-mail, thanking them for their participation. E-mails can be personalised with a facilitator’s reflections on the week’s workshop and the growth of the group. Information should be given regarding any immediate next steps planned with their films. It is also good practice to encourage the participants to stay in touch as they execute their share plans.

Facilitators should make themselves available for any questions or concerns following the workshop.

Storage of Files and Forms
It is required to save each participant’s consent form. If consent is granted to Women Win, these forms also should be forwarded to Women Win for our records. If possible, scan the consent forms and save/share electronic files in addition to the hard copies.

If storage and usage consent is granted, it is necessary to ensure safe storage of each participant’s DST folder and supporting files. All files should be backed up on the organisation’s own flash drive or external hard drive. The complete folder system (as outlined on page xx ) should be copied from the participant’s desktop and saved to the organisation’s USB or hard drive.

Distribution
If consent has been given for distribution of films to Women Win, please immediately advise us sending an email to info@womenwin.org. All supporting files should be shared, to include the share plans, bios and consent forms.

DST films can also be shared on Women Win’s DST portal at www.womenwin.org/DST. Film files from YouTube and Vimeo or audio files can be uploaded.
Resources

BUILDING DREAMS TOGETHER

IF YOU LOVE IT YOU CAN DO IT

UMUTIMA

EMIL

DONNA
### Digital Storytelling Workshop Template

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td></td>
</tr>
<tr>
<td>Organisation:</td>
<td></td>
</tr>
<tr>
<td>Position:</td>
<td></td>
</tr>
<tr>
<td>Brief Biography of yourself (2-3 sentences):</td>
<td></td>
</tr>
<tr>
<td>Quote about the DST process:</td>
<td></td>
</tr>
<tr>
<td>Mission statement for your story:</td>
<td></td>
</tr>
<tr>
<td>Also, please attach a photo of yourself that you want to accompany your story, as well as a photo that you would like to be the background of your story as it plays online.</td>
<td></td>
</tr>
</tbody>
</table>
Digital Storytelling Workshop Sample Script

(note the use of bold and in-script comment to note voice fluctuations.)

Title: MOVE ON! MOVE!

It was discouraging and disappointing when I first kicked the ball. Everyone was like Doreen! How will you make it?

All my family members and relatives didn’t think I could perform and this affected me.

At times I could just stand still recalling on the statement, particularly from my parents, because I felt disowned.

But my games teacher motivated me. MOVE ON! GOOD KICK!, MOVE!

I was proud to prove them wrong at the end of the match when my team won the tournament through my struggle and hard work as the last man defender of the team.

Football and I became friends, the best friend I never thought I could have because whenever I went for a match I always drove joy and future.

I grew passion in it when I joined Moving the Goalposts, an organization that empowers girls and young women through football.

In the organization, I discovered my potentials and capacities which had been buried by cultural ties.

I developed confidence... courage... and self-esteem; skills that motivated me to move on and fulfil my future.

Today, I am self-reliant and furthering my tertiary education because I ignored the discouragements and disappointments.

The skills enabled me to become a great leader among my peers and the entire community.

Yes! My leadership dream became true because I have been able to empower girls and young women in the community ... to identify their pathways and successful accomplishes despite the discouragements and disappointments that come their ways.

SAY NO to discouragements and MOVE ON.

Audacity Cheat Sheet

Selected **Menu Commands** are used frequently in creating an audio recording. Many of the menu commands can be accessed through the menus described farther down.

- **File > New**  
  Create a new project
- **File > Save Project**  
  Save a project that requires further editing in Audacity format
- **File > Export as MP3**  
  Export an Audacity project file in MP3 format
- **View > Float/Dock**  
  Undock/dock selected Audacity toolbar
- **Project > Import Audio**  
  Import an audio track into the current project
- **Project > New Audio Track**  
  Add a new audio track at the bottom of the stack
- **Effect > Amplify**  
  Change the volume of selected audio
- **Effect > Change Pitch**  
  Change the pitch/frequency of selected audio without affecting the tempo
- **Effect > Change Speed**  
  Change the speed by resampling; also increases the pitch
- **Effect > Change Tempo**  
  Change the speed without affecting the pitch
- **Effect > Compressor**  
  Compress the dynamic range of selected audio by softening the loud parts while keeping the volume of the soft parts the same
- **Effect > Echo**  
  Repeat the selection with a decay, effecting a series of echoes
- **Effect > Equalization**  
  Boost/reduce arbitrary frequencies
- **Effect > Fade In**  
  Increase the volume of selected audio linearly
- **Effect > Fade Out**  
  Decrease the volume of selected audio linearly
- **Effect > Noise Removal**  
  Clean up extraneous noise from a recording
- **Effect > Repeat**  
  Repeat the selection a certain number of times
- **Effect > Reverse**  
  Reverse the selected audio so that the end of the audio is heard first and the beginning last
- **Help > Content**  
  Access the extensive, embedded documentation

The **Control Toolbar** contains buttons for record/playback control and frequently used editing tools.

Click in a track to position the cursor or click and drag to select a range of audio; can be used to select multiple tracks; shift + click a new point in the track to extend the selection

Provides detailed control over how tracks fade in and out; click and drag a green control
### Select tools
- **Rectangle and ellipse select:** Select with rectangular or elliptical shape.
- **Free select:** to select odd shapes.
- "Fuzzy" select: select similarly-colored neighboring pixels.
- **Select-by-color:** select similarly-colored pixels throughout the image.
- **Scissor select:** create a selection that intelligently "snaps" to the edges of the shape you are selecting.
- **Foreground select:** roughly select an image that is in the foreground.

### Transform tools
- **Change a layer, selection, or path**
  - **Rotate:** Turn the item around a point
  - **Scale:** Change the size
  - **Shear:** Move one side
  - **Perspective:** Move one side
  - **Flip:** Mirror the image

### Text tool
- **Create a layer of type**

### Bucket fill and Blend tools
- **Fill a layer with color or a gradient, respectively**

### Drawing tools
- **Pencil:** Draw hard edges
- **Paintbrush:** Paint soft edges
- **Eraser:** Erase marks made by other tools in this group
- **Airbrush:** Paint with soft edges and fill
- **Ink:** Paint with a calligraphic effect

### Clone tools
- **Clone:** Paint using another image as a source
- **Healing:** Similar to clone, except the copied image tries to match its surroundings
- **Perspective Clone:** Similar to clone, but copied image adjusts to a set perspective

### Adjustment tools
- **Blur/sharpen:** Blur softens edges, while sharpen makes them more crisp
- **Smudge:** Smear with a brush
- **Dodge/Burn:** Dodge lightens an image, burn darkens an image

---

**Paths tool**
- **Create Bezier curves**

**Color picker tool**
- **Select a foreground (click) or background (control-click) color from a point in your image.**

**Zoom tool**
- **Zoom in or out of your image.**

**Measure tool**
- **Measure distances in your image.**

**Move tool**
- **Move selections.**

**Align tool**
- **Align and space out images relative to one another, the document, or a selection.**

**Crop tool**
- **Remove the edges of an image.**
Digital Storyteller’s Bill of Rights

IN RELATION TO A DIGITAL STORYTELLING WORKSHOP, YOU HAVE:

• The right to know from the outset why a workshop is being carried out.
• The right to understand what is involved in the process of producing a digital story.
• The right to know who might view your finished story after the digital storytelling workshop.
• The right to ask questions at any stage of the workshop, before, during or after.
• The right to ask for teaching instructions to be repeated or made more clear.
• The right to tell your story in the way you want, within the limits of the workshop.
• The right to decide whether or not to reveal private or personal information to fellow participants and instructors during the workshop.
• The right to advice about whether revealing your identity or other personal details regarding your life that appear in your story may place you at risk of harm.
• The right to leave out information and/or photographs that identify you or others in your final story.
• The right to reject story feedback (about words and images) if it is not useful or offered in a spirit of respect/support.
• The right to decide which language to use in telling/creating your story.
• The right to be respected and supported by capable workshop facilitators.
• The right to a written consent form regarding your preferences for how your story may or may not be used, including a signed copy for your records.
• The right to know what contact and support you can expect after the workshop.

IN RELATION TO SHARING YOUR DIGITAL STORY AFTER A WORKSHOP, YOU HAVE:

• The right to decide with project partners how your story will be shared.
• The right to view and retain a copy of your story before it is shared publicly in any way.
• The right to know who is likely to screen your story and for what purposes.
• The right to know who is likely to watch or read your story and when (e.g. rough timeframe).
• The right to advice regarding the process of publicly sharing your story and the difficulties it may entail.
• The right to seek emotional support should you choose to be present when your story is shown in public.
• The right to know if any money will be made from your story being shared (e.g. to support not-for-profit human rights work).
• The right to withdraw your consent for the use of your story at any time.
• The right to information about the limits of withdrawing consent for your story to be shared, if it has already been circulated online or via CD, DVD, etc.

Adapted from http://storycenter.org/ethical-practice/
Certificate of Completion
DIGITAL STORYTELLING WORKSHOP

IS AWARDED TO

FOR HER ACTIVE AND ENGAGED PARTICIPATION

Date:

Maria Bobenrieth
Women Win
3. Workshop Energisers

While it is good practice as a facilitator to always be prepared with an energiser or two, especially as an ice-breaking activity. To promote participation, we encourage facilitators to also ask workshop participants to lead energisers that they know. Listed below are a few ideas, including inclusive energisers to include participants with disabilities.

1. Imaginary ball juggle
   1. Everyone gets in a circle or stands up from their chair.
   2. The facilitator starts juggling an imaginary ball (either using their feet, their shoulder, head, elbow, buttock, knee, thigh, any part of the body). After a couple of seconds, the facilitator calls out someone’s name and using the body part they are juggling with, must hit the ball to that person.
   3. That person accepts the ball and starts juggling with another body part, then does the same thing, saying someone’s name and passing the ball to them.
   4. When passing the ball, the participant must made a sound, which represent the ball being passed. This could be “whoosh” or “zoom.” Tell participants to be creative.

2. Honey Walk
   1. Ask everyone to get into one line. Explain that in front of the line, there is a pool of a certain substance, that you will explain to them, and they must walk across that “pool” of substance as if it is really there. For example, if you say there is honey, the entire group must walk across the pool of “honey” as if their shoes are sticking to the honey, making exaggerated moves with their legs to unstick their shoes and keep moving forward. Encourage everyone to be creative, making appropriate noises, for example, if they are walking across hot coals. Ask the group to come up with substances as well
   2. Below are several examples of substances:
      A- Honey
      B- Feathers
      C- Hot coals
      D- Ice
      E- Banana peels
**Move Like You Mean It**

1. Ask the girls to get into a large circle. Each girl must think of a special move for herself. (For example, she can wiggle their arms or do a funny dance).
2. Pick a girl to begin with. In her spot in the circle she must do her special move and say her first name.
3. Then, the girl to her right must mimic the move the girl before her made and say her name and then make her own special move and say her own name.
4. The next girl must do the same thing but mimic both the moves of the first and second girl and say their names.
5. This continues until the last girl, who must remember everyone’s special move and name before she does her own.
6. If the girls get stuck and can’t remember a name or a move, tell the other girls that they can help her out.

* this can be done to the rhythm of a song that goes “My name is (insert name)” clap clap “and this is my dance,” clap clap.

---

**Lion, Warrior, Old Lady**

1. Split the girls into two teams. Have the form two lines shoulder to shoulder so that each team is facing each other.
2. Explain that they will be playing the game rock, paper scissors but human style (this game might be called different things in different cultures).
3. The three characters are lion, warrior and old lady. The lion beats old lady, the old lady beats the warrior and the warrior beats the lion.
4. To make the lion, the girls must roar loudly and put their hands up like claws. To make the warrior, the girls must make a stance as if they are shooting an arrow. To make the old lady, the girls must hunch over their back and pretend to be using a cane.
5. Start with one side of the line. The first two girls on each team will jump up and down three times. On the third time, when they land, they must make either a lion, warrior or old lady.
6. The winner will win point for her team. Go down the line until you go through all the girls. The team with the most points wins.

---

**Two Truths and a Lie**

1. Ask each girl to write down on a piece of paper two things that are true about her and one lie. Explain that we will be trying to guess which things are true and which one is the lie so she must write a lie that is difficult to tell it is a lie.
2. If you want, before the girls write their truths and lies, do an example by giving the girls two truths and one lie about yourself and having them guess.
3. After each girl has written her three things, go around the group and have them read out loud what they wrote. Then, have the whole group try to guess which two are true and which is the lie. See who’s two truths and a lie fools the most.
Beat the Feet

1. Everyone must sit in a circle and put their feet into the circle.
2. Choose one person to sit in the middle of the circle, ready to tag people’s feet.
3. A participant starts by saying a girl’s name in the circle. The tagger must try to tag her feet before she can say another girl’s name in the circle.
4. If the tagger is able to tag her feet before she says someone else’s name, she is now in the middle.
5. You cannot say the name of the person who just said your name or you are in the middle.
6. You also cannot pull your feet back as someone is trying to tag them or else you go into the middle.

I’m Listening

(inclusive energiser - does not require standing)

1. Ask girls to get into partners. Tell them they have two minutes to tell each other about their weekends. The rule is they have to talk at the same time.
2. After two minutes, call them back and have them try to tell the whole group what their partner did. They probably won’t be able to tell much since they were talking and not really listening.
3. Now, have each pair go back and take another 2 minutes to tell each other about their weekends but separately so one person is talking and the other is listening.
4. After 2 minutes, bring everyone back together and ask what the difference was in the conversations.

Knee Tag

(inclusive energiser - does not require sound)

1. Divide the group into pairs. The two will play against each other.
2. The pairs face each other and the object of the game is simply to touch the other person’s knees to get points. At the same time you must move to protect your own knees.
3. Pairs play to 5 points and then change partners.
Women Win believes that a true outcome goes beyond what we as an organisation do, but above and beyond rests upon what the programme accomplishes. In other words, we measure outcome in what change happens for those being served because of what the programme does. We therefore have developed a specific framework of indicators based on the B.A.C.K.S. Impact Framework.

These are changes in Behaviour, Attitude, Condition, Knowledge and Status. This framework allows us to contextualise the outcomes, and make concepts such as empowerment and leadership more S.M.A.R.T. (specific, measurable, achievable, relevant, time-phrased) and comparative in both qualitative and quantitative terms. Women Win defines the B.A.C.K.S. as representing changes in:

**BEHAVIOUR:**
The way in which one acts, especially towards others.

**ATTITUDE:**
A settled way of thinking or feeling – a point of view – that shows a person’s sense of self and values (attitudes inform behaviour)

**CONDITION:**
The state of a person against a specific situation, context or circumstance which affects the way in which people live (for example conflict, vulnerability, safety)

**KNOWLEDGE:**
The facts, information and skills a person acquires through experience or education

**STATUS:**
A position in a community – the way how others perceive you, or label you based on personal and particular characteristics.

---

4. Other Useful DST Projects

Below is a list of additional websites that Women Win finds useful in relation to digital storytelling.

Centre for Digital Storytelling  
[http://www.storycenter.org](http://www.storycenter.org)

Take Back the Tech  
[https://www.takebackthetech.net](https://www.takebackthetech.net)

Insight Share  
[http://www.insightshare.org](http://www.insightshare.org)

Sonke Gender Justice  
This toolkit is a work in progress. Women Win will update the content based on new knowledge that comes with implementing Digital Storytelling workshops in new environments and situations. Your feedback is welcome!

**Contributors**
- Karen Holst
- Alison Carney
- Eleni Stergiopoulou
- Nicole Matuska
- Sarah Murray
- Werkplaats Amsterdam

**Special Thanks**
- DFID
- Women Win Programme Partners